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About the Documentation

IN THIS SECTION

Documentation and Release Notes | ix

Documentation Conventions | ix

Documentation Feedback | xii

Requesting Technical Support | xii

Use this guide to understand how you can enable vulnerability assessment and use that data to build
profiles of attackers and targets.

Documentation and Release Notes

To obtain the most current version of all Juniper Networks® technical documentation, see the product
documentation page on the Juniper Networks website at https://www.juniper.net/documentation/.

If the information in the latest release notes differs from the information in the documentation, follow the
product Release Notes.

Juniper Networks Books publishes books by Juniper Networks engineers and subject matter experts.
These books go beyond the technical documentation to explore the nuances of network architecture,
deployment, and administration. The current list can be viewed at https://www.juniper.net/books.

Documentation Conventions

Table 1 on page x defines notice icons used in this guide.

ix

https://www.juniper.net/documentation/
https://www.juniper.net/books


Table 1: Notice Icons

DescriptionMeaningIcon

Indicates important features or instructions.Informational note

Indicates a situation that might result in loss of data or hardware
damage.

Caution

Alerts you to the risk of personal injury or death.Warning

Alerts you to the risk of personal injury from a laser.Laser warning

Indicates helpful information.Tip

Alerts you to a recommended use or implementation.Best practice

Table 2 on page x defines the text and syntax conventions used in this guide.

Table 2: Text and Syntax Conventions

ExamplesDescriptionConvention

To enter configuration mode, type
the configure command:

user@host> configure

Represents text that you type.Bold text like this

user@host> show chassis alarms

No alarms currently active

Represents output that appears on
the terminal screen.

Fixed-width text like this

• A policy term is a named structure
that defines match conditions and
actions.

• Junos OS CLI User Guide

• RFC 1997, BGP Communities
Attribute

• Introduces or emphasizes important
new terms.

• Identifies guide names.

• Identifies RFC and Internet draft
titles.

Italic text like this
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Table 2: Text and Syntax Conventions (continued)

ExamplesDescriptionConvention

Configure the machine’s domain
name:

[edit]
root@# set system domain-name
domain-name

Represents variables (options for
which you substitute a value) in
commands or configuration
statements.

Italic text like this

• To configure a stub area, include
the stub statement at the [edit
protocols ospf area area-id]
hierarchy level.

• The console port is labeled
CONSOLE.

Represents names of configuration
statements, commands, files, and
directories; configuration hierarchy
levels; or labels on routing platform
components.

Text like this

stub <default-metric metric>;Encloses optional keywords or
variables.

< > (angle brackets)

broadcast | multicast

(string1 | string2 | string3)

Indicates a choice between the
mutually exclusive keywords or
variables on either side of the symbol.
The set of choices is often enclosed
in parentheses for clarity.

| (pipe symbol)

rsvp { # Required for dynamic MPLS
only

Indicates a comment specified on the
same line as the configuration
statement to which it applies.

# (pound sign)

community name members [
community-ids ]

Encloses a variable for which you can
substitute one or more values.

[ ] (square brackets)

[edit]
routing-options {
static {
route default {
nexthop address;
retain;

}
}

}

Identifies a level in the configuration
hierarchy.

Indention and braces ( { } )

Identifies a leaf statement at a
configuration hierarchy level.

; (semicolon)

GUI Conventions
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Table 2: Text and Syntax Conventions (continued)

ExamplesDescriptionConvention

• In the Logical Interfaces box, select
All Interfaces.

• To cancel the configuration, click
Cancel.

Represents graphical user interface
(GUI) items you click or select.

Bold text like this

In the configuration editor hierarchy,
select Protocols>Ospf.

Separates levels in a hierarchy of
menu selections.

> (bold right angle bracket)

Documentation Feedback

We encourage you to provide feedback so that we can improve our documentation. You can use either
of the following methods:

• Online feedback system—Click TechLibrary Feedback, on the lower right of any page on the Juniper
Networks TechLibrary site, and do one of the following:

• Click the thumbs-up icon if the information on the page was helpful to you.

• Click the thumbs-down icon if the information on the page was not helpful to you or if you have
suggestions for improvement, and use the pop-up form to provide feedback.

• E-mail—Send your comments to techpubs-comments@juniper.net. Include the document or topic name,
URL or page number, and software version (if applicable).

Requesting Technical Support

Technical product support is available through the Juniper Networks Technical Assistance Center (JTAC).
If you are a customer with an active Juniper Care or Partner Support Services support contract, or are
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covered under warranty, and need post-sales technical support, you can access our tools and resources
online or open a case with JTAC.

• JTAC policies—For a complete understanding of our JTAC procedures and policies, review the JTACUser
Guide located at https://www.juniper.net/us/en/local/pdf/resource-guides/7100059-en.pdf.

• Productwarranties—For productwarranty information, visit https://www.juniper.net/support/warranty/.

• JTAC hours of operation—The JTAC centers have resources available 24 hours a day, 7 days a week,
365 days a year.

Self-Help Online Tools and Resources

For quick and easy problem resolution, Juniper Networks has designed an online self-service portal called
the Customer Support Center (CSC) that provides you with the following features:

• Find CSC offerings: https://www.juniper.net/customers/support/

• Search for known bugs: https://prsearch.juniper.net/

• Find product documentation: https://www.juniper.net/documentation/

• Find solutions and answer questions using our Knowledge Base: https://kb.juniper.net/

• Download the latest versions of software and review release notes:
https://www.juniper.net/customers/csc/software/

• Search technical bulletins for relevant hardware and software notifications:
https://kb.juniper.net/InfoCenter/

• Join and participate in the Juniper Networks Community Forum:
https://www.juniper.net/company/communities/

• Create a service request online: https://myjuniper.juniper.net

To verify service entitlement by product serial number, use our Serial Number Entitlement (SNE) Tool:
https://entitlementsearch.juniper.net/entitlementsearch/

Creating a Service Request with JTAC

You can create a service request with JTAC on the Web or by telephone.

• Visit https://myjuniper.juniper.net.

• Call 1-888-314-JTAC (1-888-314-5822 toll-free in the USA, Canada, and Mexico).

For international or direct-dial options in countries without toll-free numbers, see
https://support.juniper.net/support/requesting-support/.
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Vulnerability Assessment Scanner Overview

Integrate vulnerability assessment scanners with JSA to provide vulnerability assessment profiles for
network assets.

References to JSA apply to all products capable of collecting vulnerability assessment information.

Asset profiles for servers and hosts in your network provide information that can help you to resolve
security issues. Using asset profiles, you can connect offenses that occur on your system to the physical
or virtual assets as part of your security investigation. Asset data is helpful to identify threats, to identify
vulnerabilities, services, ports, and monitor asset usage in your network.

The Assets tab provides a unified view of the information that is known about your assets. As more
information is provided to the system through vulnerability assessment, the system updates the asset
profile. Vulnerability assessment profiles use correlated event data, network activity, and behavioral
changes to determine the threat level and vulnerabilities present on critical business assets in your network.
You can schedule scans and ensure that vulnerability information is relevant for assets in the network.

Installing the Java Cryptography Extension on JSA

The Java Cryptography Extension (JCE) is a Java framework that is required to decrypt advanced
cryptography algorithms for AES192 or AES256. The following information describes how to install Oracle
JCE on your JSA appliance.

1. Download the latest version of the Java Cryptography Extension.

The Java Cryptography Extension version must match the version of the Java installed on JSA.

2. Extract the JCE file.

The following Java archive (JAR) files are included in the JCE download:

• local_policy.jar

• US_export_policy.jar

3. Log in to your JSA Console or JSA Event Collector as a root user.

4. Copy the JCE JAR files to the following directory on your JSA Console or Event Collector:

/opt/ibm/java-x86_64/jre/lib/security/

17



NOTE: The JCE JAR files are only copied to the system that receives the AES192 or AE256
encrypted files.

5. Restart the JSA services by typing one of the following commands:

• If you are using JSA 7.2.x, type service ecs-ec restart.

• If you are using JSA 7.3.0, type systemctl restart ecs-ec.service.

• If you are using JSA 7.3.1, type systemctl restart ecs-ec-ingress.service.
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Troubleshooting Scanners
Problem
Description: If you come across a problem with your scanner, you can troubleshoot the following issues:

Solution
What do you do if the product version or device you have is not listed in the JSA Vulnerability Assessment
Configuration Guide?

Sometimes a version of a vendor product or a device is not listed as supported. If the product or device is
not listed, follow these guidelines:

• Version not listed - If the scanner is for a product that is officially supported by JSA, but the version
listed in the JSA Vulnerability Assessment Configuration Guide appears to be out-of-date, try the scanner
to see whether it works. The product versions that are listed in the guide are tested by Juniper, but
newer untested versions might also work. In most cases, no changes are necessary, or at most a minor
update may be all that is required. Software updates by vendors might on rare occasions add or change
event formats that break the scanner, requiring an RFE for the development of a new integration. This
would be the only scenario where an RFE is required. In either event, open a support ticket for a review
of the log source to troubleshoot and rule out any potential issues that are not related to the software
version.

• Device not listed - When a device is not officially supported, you have two options:

• Open a request for enhancement (RFE) to have your device become officially supported.

1. Log in to JSA.

2. Log in to the support portal page.

3. Click the Submit tab and type the necessary information.

21



3
CHAPTER

AXIS Scanner

AXIS Scanner | 25

Adding an AXIS Vulnerability Scan | 25





AXIS Scanner

You can import vulnerability data from any scanner that outputs data in Asset Export Information Source
(AXIS) format. Axis is an XML data format that was created specifically for asset and vulnerability
compatibility with JSA products.

AXIS is a standard format for scan result imports of vulnerability data. Vulnerability data for Axis scanners
must comply with the AXIS format schema to be imported successfully. To successfully integrate an AXIS
scanner with JSA, XML result files must be available on a remote server or a scanner that supports SFTP
or SMB Share communication. A remote server is a system or third-party appliance that can host the XML
scan results.

Adding an AXIS Vulnerability Scan

Add an AXIS scanner configuration to collect specific reports or start scans on the remote scanner.

The following table describes AXIS scanner parameters when you select SFTP as the import method:

Table 3: AXIS Scanner - SFTP Properties

DescriptionParameter

The IP address or host name of the server that has the
scan results files.

Remote Hostname

The user name that JSA uses to log in to the server.Login Username

Specifies that JSA authenticates with a key-based
authentication file.

Enable Key Authentication

The location of the scan result files.Remote directory

The full path to the file that contains the private key. If a
key file does not exist, you must create the vis.ssh.key
file.

Private Key File

The regular expression (regex) required to filter the list of
files that are in the Remote Directory. The .*\.xml pattern
imports all XML files from the remote directory.

File Name Pattern

The following table describes AXIS scanner parameters when you select SMB Share as the import method:
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Table 4: AXIS Scanner - SMB Share Properties

DescriptionParameter

The IP address or host name of the SMB Share.Hostname

The user name that JSA uses to log in to SMB Share.Login Username

The domain that is used to connect to the SMB Share.Domain

The full path to the share from the root of the SMB host.
Use forward slashes, for example, /share/logs/.

SMB Folder Path

The regular expression (regex) required to filter the list of
files in the Remote Directory. The .*\.xml pattern imports
all xml files in the remote directory.

File Name Pattern

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify the AXIS scanner.

5. From theManaged Host list, select the managed host that manages the scanner import.

6. From the Type list, select Axis Scanner.

7. From the Import Method list, select SFTP or SMB Share.

8. Configure the parameters.

9. Configure a CIDR range for the scanner.

10.Click Save.

11.On the Admin tab, click Deploy Changes.

For more information about how to create a scan schedule, see “Scheduling a Vulnerability Scan” on
page 195.
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Beyond Security Automatic Vulnerability Detection
System Scanner Overview

Vulnerability assessment is the evaluation of assets in the network to identify and prioritize potential
security issues. JSA products that support Vulnerability Assessment can import vulnerability data from
external scanner products to identify vulnerabilities profiles for assets.

Vulnerability assessment profiles use correlated event data, network activity, and behavioral changes to
determine the threat level and vulnerabilities present on critical business assets in your network. As external
scanners generate scan data, JSA can retrieve the vulnerability data with a scan schedule.

To configure a Beyond Security AVDS scanner, see “Adding a Beyond Security AVDSVulnerability Scanner”
on page 31.

Adding aBeyondSecurityAVDSVulnerability Scanner

Beyond Security Automated Vulnerability Detection System (AVDS) appliances create vulnerability data
in Asset Export Information Source (AXIS) format. AXIS formatted files can be imported by XML files that
can be imported.

To successfully integrate Beyond Security AVDS vulnerabilities with JSA, youmust configure your Beyond
Security AVDS appliance to publish vulnerability data to an AXIS formatted XML results file. The XML
vulnerability data must be published to a remote server that is accessible by using Secure File Transfer
Protocol (SFTP). The term remote server refers to any appliance, third-party host, or network storage
location that can host the published XML scan result files.

The most recent XML results that contain Beyond Security AVDS vulnerabilities are imported to when a
scan schedule starts. Scan schedules determine the frequency with which vulnerability data created by
Beyond Security AVDS is imported. After you add your Beyond Security AVDS appliance to JSA, create
a scan schedule to import the scan result files. Vulnerabilities from the scan schedule updates the Assets
tab after the scan schedule completes.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify your Beyond Security AVDS scanner.
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5. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.

6. From the Type list, select Beyond Security AVDS.

7. In the Remote Hostname field, type the IP address or host name of the system that contains the
published scan results from your Beyond Security AVDS scanner.

8. Choose one of the following authentication options:

DescriptionOption

To authenticate with a user name and password:

1. In the Login Username field, type a username that has
access to retrieve the scan results from the remote
host.

2. In the Login Password field, type the password that
is associated with the user name.

Login Username

To authenticate with a key-based authentication file:

1. Select the Enable Key Authentication check box.

2. In the Private Key File field, type the directory path
to the key file.

The default directory for the key file
is/opt/qradar/conf/vis.ssh.key.

If a key file does not exist, you must create the vis.ssh.key
file.

Enable Key Authorization

9. In the Remote Directory field, type the directory location of the scan result files.

10. In the File Name Pattern field, type a regular expression (regex) to filter the list of files that are specified
in the Remote Directory. All matching files are included in the processing.

The default value is .*\.xml. The .*\.xml pattern imports all xml files in the remote directory.

11. In theMax Reports Age (Days) field, type the maximum file age for your scan results file. Files that are
older than the specified days and timestamp on the report file are excluded when the schedule scan
starts. The default value is 7 days.

12. To configure the Ignore Duplicates option:
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• Select this check box to track files that are already processed by a scan schedule. This option prevents
a scan result file from being processed a second time.

• Clear this check box to import vulnerability scan results each time the scan schedule starts. This
option can lead to multiple vulnerabilities associated with one asset.

If a result file is not scanned within 10 days, the file is removed from the tracking list and is processed
the next time the scan schedule starts.

13. To configure a CIDR range for your scanner:

a. Type the CIDR range for the scan or click Browse to select a CIDR range from the network list.

b. Click Add.

14.Click Save.

15.On the Admin tab, click Deploy Changes.

You are now ready to create a scan schedule. See “Scheduling a Vulnerability Scan” on page 195.
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Digital Defense Inc AVS Scanner Overview

The Digital Defense, Inc. AVS scanner module accesses vulnerability data from the Digital Defense, Inc.
Frontline Vulnerability Manager (Frontline VM) by using the Frontline Connect API.

The Frontline Connect API works with JSA to collect vulnerability information.

JSA users can activate the Digital Defense vulnerability feeds in JSA to gather more information about
security events by correlating vulnerability and threat data. Greater visibility is provided about the risk
posture of hosts so that the user can make better, more informed decisions, and then take appropriate
security action.

Before JSA can collect Digital Defense Frontline VM vulnerability data, you must complete the following
steps:

1. Install the Frontline Vulnerability Manager SSL Certificate on page 37

2. Creating an API Key in Frontline Vulnerability Manager on page 38

3. Adding a Digital Defense AVS Scanner on page 39

RELATED DOCUMENTATION

Install the Frontline Vulnerability Manager SSL Certificate | 37

Creating an API Key in Frontline Vulnerability Manager | 38

Adding a Digital Defense AVS Scanner | 39

Install the Frontline Vulnerability Manager SSL
Certificate

Before JSA can collect Digital Defense VM vulnerability data, you must download an SSL certificate.

The certificate must have a .crt, .cert, or .der file extension.

Copy the SSL certificate to the /opt/qradar/conf/trusted_certificates directory in JSA, by using one of
the following options:

• Manually copy the certificate to the /opt/qradar/conf/trusted_certificates directory by using SCP or
SFTP.
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• SSH into your JSA Console or managed host and then type the following command:

/opt/qradar/bin/getcert.sh <IP or hostname of Frontline VM device>

When you use this command, the certificate for your Frontline VM is downloaded and placed into the
/opt/qradar/conf/trusted_certificates directory in the appropriate format.

RELATED DOCUMENTATION

Creating an API Key in Frontline Vulnerability Manager | 38

Adding a Digital Defense AVS Scanner | 39

Creating anAPIKey in FrontlineVulnerabilityManager

Before JSA can collect Digital Defense Frontline VM vulnerability data, you must create an API key in
Frontline Vulnerability Manager.

1. Log in to the Frontline VM interface.

2. In the upper right side of the window, click your name, and then selectMy Profile.

3. Click API Tokens > Create New Token.

4. In the Add New Token field, type a name of your choosing for the token.

5. Select Click to show key to display the API key. Copy and record the API key. You need the API key
when you add a scanner in JSA.

NOTE: An API key is equivalent to the password of the user that created the API key. Do not
use an API Key for more than one integration. If you believe an API Key is compromised, delete
the token from the Frontline VM interface to disable it.

RELATED DOCUMENTATION

Adding a Digital Defense AVS Scanner | 39
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Install the Frontline Vulnerability Manager SSL Certificate | 37

Adding a Digital Defense AVS Scanner

JSA accesses vulnerability data from the Digital Defense, Inc. Frontline Vulnerability Manager by using
the Frontline Connect API that is installed with the Frontline Vulnerability Manager.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. From the Type list, select Digital Defense Inc AVS.

5. In the Scanner Name field, type a name to identify your Digital Defense Inc AVS scanner.

6. In the Description field, type a description for your Digital Defense Inc AVS scanner.

7. Configure the parameters.

The following table describes the parameters that require specific values for the Digital Defense Inc
AVS scanner:

DescriptionParameter

The host name of the remote server for the Digital
Defense, Inc. AVS scanner.

The host name must be vm.frontline.cloud.

Remote Host

The port number of the remote server for the Digital
Defense, Inc. AVS scanner.

The Remote Port value must be 443.

Remote Port

TheURL of the remote server for the Digital Defense, Inc.
AVS scanner.

The Remote URL value must be /nsas/blGateway.php.

Remote URL
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DescriptionParameter

A client ID is no longer used for this value. Youmight want
to type the email address of the user who requested the
API key.

Client ID

The email address of the user who requested the API key.Username

The API key that you created when you completed the
“Creating an API Key in Frontline Vulnerability Manager”
on page 38.

Password

Collects host data from internal or external hosts for the
Frontline VM. Select one of the following options:

• Internal

• External

Host Scope

From the list, select Default.Retrieve Data for Account

Specifies the method by which vulnerabilities are
correlated. Select one the following options:

All Available - Queries the Frontline VM vulnerability
catalog and correlates vulnerabilities that are based on all
of the references that are returned for that specific
vulnerability. References might include CVE, Bugtraq,
Microsoft Security Bulletin, and OSVDB. Multiple
references sometimes correlate to the same vulnerability.
More results are returned, but processing takes longer
than the CVE option.

CVE - Queries the Frontline VM vulnerability and
correlates vulnerabilities that are based only on the
CVE-ID.

Correlation Method

8. Configure the CIDR ranges that you want this scanner to retrieve by typing the CIDR range, or click
Browse to select the CIDR range from the network list.

9. Click Add > Save.

TIP: Repeat 4 to 9 to create more import parameters.
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eEye Scanner Overview

JSA can collect vulnerability data from eEye REMSecurityManagement Console or eEye Retina CS scanners.

The following protocol options are available to collect vulnerability information from eEye scanners:

• Add an SNMP protocol eEye scanner. See “Adding an EEye REM SNMP Scan” on page 45.

• Add a JDBC protocol eEye scanner. See “Adding an EEye REM JDBC Scan” on page 47.

RELATED DOCUMENTATION

Installing the Java Cryptography Extension on JSA | 17

Adding an eEye REM SNMP Scan

You can add a scanner to collect vulnerability data over SNMP from eEye REM or CS Retina scanners.

To use CVE identifiers and descriptions, you must copy the audits.xml file from your eEye REM scanner
to the managed host responsible for listening for SNMP data. If your managed host is in a distributed
deployment, you must copy the audits.xml to the Console first and SSH the file to
/opt/qradar/conf/audits.xml on themanaged host. The default location of audits.xml on the eEye scanner
is %ProgramFiles(x86)%\eEye Digital Security\Retina
CS\Applications\RetinaManager\Database\audits.xml.

To receive the most up-to-date CVE information, periodically update JSA with the latest audits.xml file.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify your SecureScout server.

5. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.

6. From the Type list, select eEye REM Scanner.
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7. From the Import Type list, select SNMP.

8. In the Base Directory field, type a location to store the temporary files that contain the eEye REM scan
data.

The default directory is /store/tmp/vis/eEye/.

9. In the Cache Size field, type the number of transactions you want to store in the cache before the
SNMP data is written to the temporary file. The default is 40.

The default value is 40 transactions.

10. In the Retention Period field, type the time period, in days, that the system stores scan information.

If a scan schedule did not import data before the retention period expires, the scan information from
the cache is deleted.

11. Select theUseVulnerabilityData check box to correlate eEye vulnerabilities to CommonVulnerabilities
and Exposures (CVE) identifiers and description information.

12. In the Vulnerability Data File field, type the directory path to the eEye audits.xml file.

13. In the Listen Port field, type the port number that is used to monitor for incoming SNMP vulnerability
information from your eEye REM scanner.

The default port is 1162.

14. In the Source Host field, type the IP address of the eEye scanner.

15. From the SNMP Version list, select the SNMP protocol version.

The default protocol is SNMPv2.

16. In theCommunity String field, type the SNMP community string for the SNMPv2 protocol, for example,
Public.

17. From the Authentication Protocol list, select the algorithm to authenticate SNMPv3 traps.

18. In theAuthentication Password field, type the password that youwant to use to authenticate SNMPv3
communication.

The password must include a minimum of 8 characters.

19. From the Encryption Protocol list, select the SNMPv3 decryption algorithm.
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20. In the Encryption Password field, type the password to decrypt SNMPv3 traps.

21. To configure a CIDR range for your scanner:

a. Type the CIDR range for the scan or click Browse to select a CIDR range from the network list.

b. Click Add.

22.Click Save.

23.On the Admin tab, click Deploy Changes.

Select one of the following options:

• If you do not use SNMPv3 or use low-level SNMP encryption, you are now ready to create a scan
schedule. See “Scheduling a Vulnerability Scan” on page 195.

• If your SNMPv3 configuration uses AES192 or AES256 encryption, you must install the unrestricted
Java cryptography extension on eachConsole ormanaged host that receives SNMPv3 traps. See “Installing
the Java Cryptography Extension on JSA” on page 17.
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Adding an eEye REM JDBC Scan

You can add a scanner to collect vulnerability data over JDBC from eEye REM or CS Retina scanners.

Before you configure JSA to poll for vulnerability data, we suggest you create a database user account
and password for JSA. If you assign the user account read-only permission to the RetinaCSDatabase, you
can restrict access to the database that contains the eEye vulnerabilities. The JDBC protocol enables JSA
to log in and poll for events from the MSDE database. Ensure that no firewall rules block communication
between the eEye scanner and the Console ormanaged host responsible for pollingwith the JDBC protocol.
If you use database instances, you must verify port 1433 is available for the SQL Server Browser Service
to resolve the instance name.

1. Click the Admin tab.

2. Click the VA Scanners icon.
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3. Click Add.

4. In the Scanner Name field, type a name to identify the eEye scanner.

5. From theManaged Host list, select the managed host from the JSA deployment that manages the
scanner import.

6. From the Type list, select eEye REM Scanner.

7. From the Import Type list, select JDBC.

8. In the Hostname field, type the IP address or the host name of the eEye database.

9. In the Port field, type 1433.

10.Optional. In the Database Instance field, type the database instance for the eEye database.

If a database instance is not used, leave this field blank.

11. In the Username field, type the username required to query the eEye database.

12. In the Password field, type the password required to query the eEye database.

13. In the Domain field, type the domain required, if required, to connect to the eEye database.

If the database is configured for Windows and inside a domain, you must specify the domain name.

14. In the Database Name field, type RetinaCSDatabase as the database name.

15. Select the Use Named Pipe Communication check box if named pipes are required to communicate
to the eEye database. By default, this check box is clear.

16. Select the Use NTLMv2 check box if the eEye scanner uses NTLMv2 as an authentication protocol.
By default, this check box is clear.

TheUseNTLMv2 check box forcesMSDEconnections to use theNTLMv2protocolwhen communicating
with SQL servers that require NTLMv2 authentication. The Use NTLMv2 check box is selected, it has
no effect on MSDE connections to SQL servers that do not require NTLMv2 authentication.

17. To configure a CIDR range for the scanner:

a. In the text field, type the CIDR range you want this scanner to consider or click Browse to select a
CIDR range from the network list.
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b. Click Add.

18.Click Save.

19.On the Admin tab, click Deploy Changes.

You are now ready to create a scan schedule. See “Scheduling a Vulnerability Scan” on page 195.
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IBM AppScan Enterprise Scanner Overview

JSA retrieves AppScan Enterprise reports with the Representational State Transfer (REST) web service to
import vulnerability data and generate offenses for your security team. AppScan Enterprise.

You can import scan results from IBMSecurity AppScan Enterprise report data, providing you a centralized
security environment for advanced application scanning and security compliance reporting. You can import
IBM Security AppScan Enterprise scan results to collect asset vulnerability information for malware, web
applications, and web services in your deployment.

To integrate AppScan Enterprise with JSA, you must complete the following tasks:

1. Generate scan reports in IBM AppScan Enterprise.

Report configuration information can be found in your IBMAppScan Enterprise documentation.

2. Configure AppScan Enterprise to grant JSA access to report data.

3. Configure your AppScan Enterprise scanner in JSA.

4. Create a schedule in JSA to import AppScan Enterprise results.

To configure IBM AppScan Enterprise to grant permission to report data, your AppScan administrator
must determine which users have permissions to publish reports to JSA. After AppScan Enterprise users
configure reports, the reports that are generated by AppScan Enterprise can be published to JSA, making
them available for download.

To configure AppScan Enterprise to grant access to scan report data, see “Creating a Customer User Type
for IBM AppScan Enterprise” on page 54.
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Creating a Customer User Type for IBM AppScan
Enterprise

You can create custom user types to assign permissions for limited and specific administrative tasks to
administrators.

1. Log in to your IBM AppScan Enterprise appliance.

2. Click the Administration tab.

3. On the User Types page, click Create.

4. Select all of the following user permissions:

• Configure Juniper Secure Analytics (JSA) Integration— Select this check box to allow users to access
the JSA integration options for AppScan Enterprise.

• Publish to JSA— Select this check box to allow JSA access to published scan report data.

• JSA Service Account— Select this check box to add access to the REST API for the user account. This
permission does not provide access the user interface.

5. Click Save.

You are now ready to enable integration permissions. See “Enabling Integration with IBM AppScan
Enterprise” on page 54
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Enabling Integration with IBM AppScan Enterprise

IBM AppScan Enterprise must be configured to enable integration with JSA.

To complete these steps, you must be logged in with a custom user type.
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1. Click the Administration tab.

2. On the Navigation menu, select Network Security Systems.

3. On the JSA Integration Setting pane, click Edit.

4. Select the Enable JSA Integration check box.

Any reports that are previously published to JSA are displayed. If any of the reports that are displayed
are no longer required, you can remove them from the list. As you publish more reports to JSA, the
reports are displayed in this list.

You are now ready to configure the ApplicationDeploymentMapping in AppScan Enterprise. See “Creating
an Application Deployment Map in IBM AppScan Enterprise” on page 55.
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Creating an Application Deployment Map in IBM
AppScan Enterprise

The Application Deployment Map allows AppScan Enterprise to determine the locations that host the
application in your production environment.

As vulnerabilities are discovered, AppScan Enterprise knows the locations of the hosts and the IP addresses
affected by the vulnerability. If an application is deployed to several hosts, then AppScan Enterprise
generates a vulnerability for each host in the scan results.

1. Click the Administration tab.

2. On the navigation menu, select Network Security Systems.

3. On the JSA Integration Setting pane, click Edit.
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4. In the Application test location (host or pattern) field, type the test location of your application.

5. In theApplication production location (host) field, type the IP address of your production environment.

To add vulnerability information to JSA, your Application Deployment Mapping must include an IP
address. If the IP address is not available in the AppScan Enterprise scan results, vulnerability data
without an IP address is excluded from JSA.

6. Click Add.

7. Repeat this procedure to map any more production environments in AppScan Enterprise.

8. Click Done.

You are now ready to publish completed reports. See “Publishing Completed Reports in IBM AppScan
Enterprise” on page 56.
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Publishing Completed Reports in IBM AppScan
Enterprise

Completed vulnerability reports that are generated by AppScan Enterprise must be made accessible to
JSA by publishing the report.

1. Click the Scan tab, and then navigate to the security report that you want to make available to JSA.

2. On the menu bar of any security report, select Publish > grant reports to JSA to provide report access
to JSA.

You are now ready to enable integration permissions. See “Adding an IBMAppScan Enterprise Vulnerability
Scanner” on page 57.
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Adding an IBM AppScan Enterprise Vulnerability
Scanner

You can add a scanner to define which scan reports in IBM Security AppScan are collected by JSA.

If your AppScan installation is set up to use HTTPS, a server certificate is required. JSA supports certificates
with the following file extensions: .crt, .cert, or .der. To copy a certificate to the
/opt/qradar/conf/trusted_certificates directory, choose one of the following options:

• Manually copy the certificate to the /opt/qradar/conf/trusted_certificates directory by using SCP or
SFTP.

• SSH into the Console or managed host and retrieve the certificate by using the following command:
/opt/qradar/bin/getcert.sh <IP or Hostname> <optional port - 443 default>. A certificate is then
downloaded from the specified host name or IP and placed into /opt/qradar/conf/trusted_certificates
directory in the appropriate format.

You can add multiple IBM AppScan scanners to JSA, each with a different configuration. Multiple
configurations provide JSA the ability to import AppScan data for specific results. The scan schedule
determines the frequencywithwhich scan results are imported from the RESTweb service in IBMAppScan
Enterprise.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify your IBM AppScan Enterprise scanner.

5. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.

6. From the Type list, select IBM AppScan Scanner.
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7. In the ASE Instance Base URL field, type the full base URL of the AppScan Enterprise instance. HTTP
and HTTPS are supported in the URL address.

Example: XML API - http://myasehostname/ase

Example: JSON API - http://myasehostname/ase/api

8. From the API Type list, select one of the following options:

• XML (Before v9.02)— If your version of AppScan Enterprise is earlier than v9.02, select this option.
This API type uses the AppScan XML REST web service.

• JSON (v9.0.2 and later)— If your version of AppScan Enterprise is version 9.02 or later, select this
option. This API type uses the AppScan JSON REST web service.

9. If you selected XML (Before v9.02) as the API Type, select one of the following options from the
Authentication Type list:

• WindowsAuthentication (AppScan Enterprise 9.0 and previous)—Select this option to useWindows
Authentication with the REST web service.

• AppScan Enterprise Authentication— Select this option to use AppScan Enterprise Authentication
with the REST web service.

10. In the Username field, type the user name to retrieve scan results from AppScan Enterprise.

11. In the Password field, type the password to retrieve scan results from AppScan Enterprise.

12. In the Report Name Pattern field, type a regular expression (regex) to filter the list of vulnerability
reports available from AppScan Enterprise.

By default, the Report Name Pattern field contains .* as the regex pattern. The .* pattern imports all
scan reports that are published to JSA. All matching files from the file pattern are processed by JSA.
You can specify a group of vulnerability reports or an individual report by using a regex pattern.

13.Configure a CIDR range for your scanner:

a. Type the CIDR range for the scanner or click Browse to select a CIDR range from the network list.

b. Click Add.

14.Click Save.

15.On the Admin tab, click Deploy Changes.

You are now ready to create a scan schedule for IBM AppScan Enterprise. See “Scheduling a Vulnerability
Scan” on page 195.
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IBM Guardium Scanner Overview

IBM InfoSphere Guardium appliances are capable of exporting database vulnerability information that can
be critical to protecting customer data.

IBMGuardium audit processes export the results of tests that fail the CommonVulnerability and Exposures
(CVE) tests generated when running security assessment tests on your IBM Guardium appliance. The
vulnerability data from IBM Guardium must be exported to a remote server or staging server in Security
Content Automation Protocol (SCAP) format. JSA can then retrieve the scan results from the remote server
storing the vulnerability using SFTP.

IBM Guardium only exports vulnerability from databases containing failed CVE test results. If there are
no failed CVE tests, IBM Guardium may not export a file at the end of the security assessment. For
information on configuring security assessment tests and creating an audit process to export vulnerability
data in SCAP format, see your IBM InfoSphere Guardium documentation.

After you have configured your IBM Guardium appliance, you are ready to configure JSA to import the
results from the remote server hosting the vulnerability data. You must add an IBM Guardium scanner to
JSA and configure the scanner to retrieve data from your remote server. The most recent vulnerabilities
are imported by JSAwhen you create a scan schedule. Scan schedules allow you to determine the frequency
with which JSA requests data from the remote server host your IBM Guardium vulnerability data.

Integration overview for IBM InfoSphere Guardium and JSA.

1. On your IBM InfoSphere Guardium appliance, create an SCAP file with your vulnerability information.
See your IBM InfoSphere Guardium documentation.

2. On your JSA Console, add an IBM Guardium scanner. See “Adding an IBM Guardium Vulnerability
Scanner” on page 63

3. On your JSA Console, create a scan schedule to import scan result data. See“Scheduling a Vulnerability
Scan” on page 195

Adding an IBM Guardium Vulnerability Scanner

Adding a scanner allows JSA to collect SCAP vulnerability files from IBM InfoSphere Guardium.

Administrators can add multiple IBM Guardium scanners to JSA, each with a different configuration.
Multiple configurations provide JSA the ability to import vulnerability data for specific results. The scan
schedule determines the frequency with which the SCAP scan results are imported from IBM InfoSphere
Guardium.

63



1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify your IBM Guardium scanner.

5. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.

6. From the Type list, select IBM Guardium SCAP Scanner.

7. Choose one of the following authentication options:

DescriptionOption

To authenticate with a user name and password:

1. In the Login Username field, type a username that has
access to retrieve the scan results from the remote
host.

2. In the Login Password field, type the password
associated with the user name.

Login Username

To authenticate with a key-based authentication file:

1. Select the Enable Key Authentication check box.

2. In the Private Key File field, type the directory path
to the key file.

The default is directory for the key file
is/opt/qradar/conf/vis.ssh. If a key file does not exist,
you must create the vis.ssh key file.

Enable Key Authorization

8. In the Remote Directory field, type the directory location of the scan result files.

9. In the File Name Pattern field, type a regular expression (regex) required to filter the list of SCAP
vulnerability files specified in theRemoteDirectory field. All matching files are included in the processing.

By default, the Report Name Pattern field contains .*\.xml as the regex pattern. The .*\.xml pattern
imports all xml files in the remote directory.
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10. In theMax Reports Age (Days) field, type the maximum file age for your scan results file. Files that are
older than the specified days and timestamp on the report file are excluded when the schedule scan
starts. The default value is 7 days.

11. To configure the Ignore Duplicates option:

• Select this check box to track files that have already been processed by a scan schedule. This option
prevents a scan result file from being processed a second time.

• Clear this check box to import vulnerability scan results each time the scan schedule starts. This
option can lead to multiple vulnerabilities being associated with an asset.

If a result file is not scanned within 10 days, the file is removed from the tracking list and is processed
the next time the scan schedule starts.

12. To configure a CIDR range for your scanner:

a. In the text field, type the CIDR range you want this scanner to consider or click Browse to select a
CIDR range from the network list.

b. Click Add.

13.Click Save.

14.On the Admin tab, click Deploy Changes.

You are now ready to create a scan schedule for IBM InfoSphere Guardium. See “Scheduling a Vulnerability
Scan” on page 195
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Configuring Guardium to Produce Report in AXIS
Format

You can integrate IBM InfoSphere Guardiumwith JSA by using the Asset Export Information Source (AXIS)
scanner. However, you must ensure that the Guardium vulnerability assessment reports are exported as
AXIS format.
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1. Log in to the IBM InfoSphere Guardium.

2. Click the Tools tab.

3. From the Tools page, select Security Assessment Builder.

4. Click New to create a new assessment.

5. From the Security Assessment Builder page, Enter theDescription, Period From, To,Client Ip (optional),
and Server Ip (optional).

6. Click Add Datasource and add the data sources that you want to run the assessment tests on.

7. From the Datasource Finder page, select a data source, and click Add.

8. Click Apply to save the newly added data source.

9. Add tests to the assessment by clicking Configure Test.

10. Select tests from an inventory of available tests, and clickAdd Selections to add them to the assessment.

11.Click Return.

12. To run the assessment, click Run Once Now.

13. From theAssessment Results screen, clickCreate AXIS Results to generate an output file in axis format.
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IBM SiteProtector Scanner Overview

The IBMSiteProtector scannermodule for JSA accesses vulnerability data from IBMSiteProtector scanners
through Java Database Connectivity (JDBC) queries.

The IBM SiteProtector scanner retrieves vulnerability data from the RealSecureDB table and polls for new
vulnerabilities each time a scan schedule starts. The Compare field enables the query to retrieve any new
vulnerabilities from the RealSecureDB table to ensure that duplicate vulnerabilities are not imported.When
the IBM SiteProtector scanner is configured, the administrator can create a SiteProtector user account
specifically for polling vulnerability data. After the user account is created, the administrator can verify
that there are no firewalls that reject queries on the port configured to poll the database.

To configure an IBM SiteProtector scanner, see “Adding an IBM SiteProtector Vulnerability Scanner” on
page 69.
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Adding an IBM SiteProtector Vulnerability Scanner

JSA can poll IBM InfoSphere SiteProtector appliances for vulnerability data with JDBC.

Administrators can add multiple IBM SiteProtector scanners to JSA, each with a different configuration.
Multiple configurations provide JSA with the ability to query SiteProtector and only import results from
specific CIDR ranges. The scan schedule determines the frequency with which the database on the
SiteProtector scanner is queried for vulnerability data.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify the IBM SiteProtector scanner.

5. From theManaged Host list, select the managed host from the JSA deployment that manages the
scanner import.
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6. From the Type list, select IBM SiteProtector Scanner.

7. In the Hostname field, type the IP address or host name of the IBM SiteProtector that contains
vulnerabilities to import.

8. In the Port field, type 1433 as the port for the IBM SiteProtector database.

9. In the Username field, type the username required to query the IBM SiteProtector database.

10. In the Password field, type the password required to query the IBM SiteProtector database.

11. In theDomain field, type the domain required, if required, to connect to the IBMSiteProtector database.

If the database is configured for Windows and inside a domain, you must specify the domain name.

12. In the Database Name field, type RealSecureDB as the database name.

13. In the Database Instance field, type the database instance for the IBM SiteProtector database. If you
are not using a database instance, you can leave this field blank.

14. Select the Use Named Pipe Communication if named pipes are required to communicate to the IBM
SiteProtector database. If you are using SQL authentication, disable Named Pipe Communication. By
default, this check box is clear.

15. Select theUseNTLMv2 check box if the IBMSiteProtector uses NTLMv2 as an authentication protocol.
By default, this check box is clear.

TheUseNTLMv2 check box forcesMSDEconnections to use theNTLMv2protocolwhen communicating
with SQL servers that require NTLMv2 authentication. The Use NTLMv2 check box is selected, it has
no effect on MSDE connections to SQL servers that do not require NTLMv2 authentication.

16. To configure a CIDR range for the scanner:

a. In the text field, type the CIDR range for the scan or click Browse to select a CIDR range from the
network list.

b. Click Add.

17.Click Save.

18.On the Admin tab, click Deploy Changes.

You are now ready to create a scan schedule. See “Scheduling a Vulnerability Scan” on page 195
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Juniper Profiler NSM Scanner Overview

JSA can collect vulnerability data from the PostgreSQL database on the Juniper Profiler NSM scanner by
polling for data with JDBC.

The Juniper Networks Netscreen Security Manager (NSM) console passively collects valuable asset
information from your network through deployed Juniper Networks IDP sensors. JSA connects to the
Profiler database stored on the NSM server to retrieve these records. The JSA server must have access
to the Profiler database. JSA supports NSMversions 2007.1r2, 2007.2r2, 2008.1r2, 2009r1.1, and 2010.x.
For more information, see your vendor documentation. To collect data from the PostgreSQL database,
JSA must have access to the Postgres database port through TCP port 5432. Access is provided in the
pg_hba.conf file, which is located in /var/netscreen/DevSvr/pgsql/data/pg_hba.conf on the system that
hosts the Juniper NSM Profiler.

To add a Juniper NSM Profiler scanner, see“Adding a Juniper NSM Profiler Scanner” on page 75.

Adding a Juniper NSM Profiler Scanner

Administrators can add a Juniper NSM Profiler scanner to poll for vulnerability data with JDBC.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify your Juniper NSM Profiler server.

5. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.

Certificates for your Juniper NSM Profiler scanner must reside on the managed host selected in the
Managed Host list.
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6. From the Type list, select Juniper NSM Profiler Scanner, and then configure the parameters.

DescriptionParameter

The IP address or host name of the Juniper NSM Profiler
scanner that contains the vulnerabilities you want to
retrieve.

Server Host Name

The user name that is required to access the Juniper NSM
Profiler scanner.

Database Username

The password that is required to access the Juniper NSM
Profiler scanner.

Database Password

The name of the database on the above server that
contains the Juniper NSM Profiler scanner data.

Database Name

7. To configure a CIDR range for your scanner complete the following steps:

a. In the text field, type the CIDR range for the scanner or click Browse to select a CIDR range from
the network list.

b. Click Add.

8. Click Save.
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McAfee Vulnerability Manager Scanner Overview

TheMcAfee VulnerabilityManager scanner enables JSA to import vulnerabilities from an XML file or query
for a results file from the McAfee OpenAPI.

JSA can collect vulnerability data fromMcAfee Vulnerability Manager appliances. The following software
versions are supported

• v6.8 and v7.0 for the McAfee Vulnerability Manager SOAP API

• v6.8, v7.0, and v7.5 for remote XML imports

The following import options are available to collect vulnerability information from McAfee Vulnerability
Manager:

• To add a remote XML import for vulnerability data, see “Adding a Remote XML Import Scan” on page 79.

NOTE: When you export from McAfee Vulnerability Manager, you must click the Scan Reports
tab, and then select the XML output option.

• To retrieve vulnerabilities from the SOAP API, see “Adding a McAfee Vulnerability Manager SOAP API
Scan” on page 84

Adding a Remote XML Import Scan

TheMcAfee Vulnerability Manager scanner enables JSA to import vulnerabilities from an XML file by way
of SFTP, SMB, or query for a results file from the McAfee OpenAPI.

JSA can collect vulnerability data fromMcAfee Vulnerability Manager appliances. The following software
versions are supported

• v6.8 and v7.0 for the McAfee Vulnerability Manager SOAP API

• v6.8, v7.0, and v7.5 for remote XML imports

The following import options are available to collect vulnerability information from McAfee Vulnerability
Manager:

• Add a remote XML import for vulnerability data by way of SFTP.

• Add a remote XML import for vulnerability data by way of SMB.
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NOTE: When you export from McAfee Vulnerability Manager, you must click the Scan Reports
tab, and then select the XML output option.

• Retrieve vulnerabilities from the SOAP API.

Configuring Remote Exports for McAfee Vulnerability Manager

To import scan reports into JSA, you can configure McAfee Vulnerability Manager to export scan reports
to a remote server.

Configure the McAfee Vulnerability Manager to export scan results to a remote server. You can import
scan results into JSA from the remote repository by using a secure file transfer protocol (SFTP) or a server
message block (SMB) protocol.

NOTE: The export is a compressed file that contains HostData and RiskData XML files. Only
HostData XML files are supported because they contain the required host and vulnerability
information. Ensure that only uncompressedHostData XML files are placed in the remote directory
or that the file name pattern that you configure matches only uncompressed HostData reports
XML files.

1. Log in to the configurationmanagement server. Click Start, and then selectAll Programs > Foundstone
> FCM Console.

2. Select Tools >Preferences , and then click the Report Server tab.

3. Select Copy Reports to a Network Drive.

4. Type the path to the network drive. For example, \\CompName\ShareName.

5. Click Apply.

NOTE: If theReport Server service does not have the correct permissions to the network drive,
configure the settings for the Report Server service.
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Adding a Remote XML Import Scan Via SFTP

Use SFTP to import the HostData XML vulnerability data that is created by your McAfee Vulnerability
Manager appliance.

Ensure that the McAfee Vulnerability Manager is configured to export scan results to a remote server.

JSA connects to the remote repository via SFTP and imports completed XML scan reports from the remote
directory.

You can use the file import collectionmethod to import completed scan reports fromMcAfee Vulnerability
Manager V7.0 and V7.5.

NOTE:

1. The import might contain HostData and RiskData XML files. Only HostData XML files are
supported because they contain the required host and vulnerability information. Ensure that
only HostData XML files are placed in the remote directory or that the file name pattern that
you configure matches only HostData reports.

2. The export is a compressed file that contains HostData and RiskData XML files. Only HostData
XML files are supported because they contain the required host and vulnerability information.
Ensure that only uncompressed HostData XML files are placed in the remote directory or that
the file name pattern that you configure matches only uncompressed HostData reports XML
files.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify McAfee Vulnerability Manager.

5. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.

6. From the Type list, selectMcAfee Vulnerability Manager.

7. From the Import Type list, select Remote XML Import.
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8. In the Remote Hostname field, type the IP address or host name of the remote server that hosts your
McAfee Vulnerability Manager XML data.

9. In the Remote Port field, type the port to retrieve the XML vulnerability data.

10.Choose one of the following authentication options:

DescriptionOption

Authenticates with a user name and password. The
password must not contain the ! character. This character
might cause authentication failures over SFTP.

Login Username

Authenticate with a key-based authentication file. If a key
file does not exist, youmust create the vis.ssh.key file and
place it in the /opt/qradar/conf/vis.ssh.key directory.

Enable Key Authorization

11. In the Remote Directory field, type the directory path to the XML vulnerability data.

12. In the File Name Pattern field, type a regular expression (regex) to filter the list of files that are specified
in the Remote Directory. All matching files are included in the processing. Ensure that this pattern
matches only HostData XML reports.

13. In theMax Reports Age (days) field, type the maximum file age for your scan results file.

14. To configure a CIDR range for the scanner:

a. In the text field, type the CIDR range for the scan or click Browse to select a CIDR range from the
network list.

b. Click Add.

15.Click Save.

16.On the Admin tab, click Deploy Changes.

Adding a Remote XML Import Scan Via SMB

Use SMB to connect to a remote server and import the HostData XML vulnerability data that is created
by your McAfee Vulnerability Manager appliance.

Ensure that the McAfee Vulnerability Manager is configured to export scan results to a remote server.
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JSA connects to the remote repository via SMB, and imports completed XML scan reports from a remote
directory.

You can use the file import collectionmethod to import completed scan reports fromMcAfee Vulnerability
Manager V7.0 and V7.5.

NOTE:

1. The import might contain HostData and RiskData XML files. Only HostData XML files are
supported because they contain the required host and vulnerability information. Ensure that
only HostData XML files are placed in the remote directory or that the file name pattern that
you configure matches only HostData reports.

2. The export is a compressed file that contains HostData and RiskData XML files. Only HostData
XML files are supported because they contain the required host and vulnerability information.
Ensure that only uncompressed HostData XML files are placed in the remote directory or that
the file name pattern that you configure matches only uncompressed HostData reports XML
files.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify McAfee Vulnerability Manager.

5. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.

6. From the Type list, selectMcAfee Vulnerability Manager.

7. From the Import Type list, select SMB Share.

8. In the Hostname field, type the user name of the remote server that hosts your McAfee Vulnerability
Manager XML data.

9. In the Login Username field, type the user name that JSA uses to log in to the SMB Share.

10. In the Login Password field, type the password that JSA uses to log in to the SMB Share.
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11. In the Domain field, type the domain that is used to connect to the SMB Share.

12. In the SMBFolder Path field, type the full path to the share from the root of the SMB host. Use forward
slashes when you type the path. For example, /share/logs.

13. In the File Name Pattern field, type a regular expression (regex) to filter the list of files that are specified
in the remote directory. All matching files are included in the processing. Ensure that this pattern
matches only HostData XML reports.

14. In the Max Reports Age (days) field, type the maximum file age for your scan results file.

15.Configure a CIDR range for the scanner.

a. In the text field, type the CIDR range for the scan, or click Browse to select a CIDR range from the
network list.

b. Click Add.

16.Click Save.

17.On the Admin tab, click Deploy Changes.
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Adding a McAfee Vulnerability Manager SOAP API
Scan

You can add a McAfee Vulnerability Manager scanner to enable JSA to collect host and vulnerability
information through the McAfee OpenAPI.

1. Click the Admin tab.

2. Click the VA Scanners icon.
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3. Click Add.

4. In the Scanner Name field, type a name to identify the scanner.

5. From theManaged Host list, select the managed host that manages the scanner import.

Certificates for the scanner must be on the managed host that is selected in theManaged Host list.

6. From the Type list, selectMcAfee Vulnerability Manager.

7. In the SOAP API URL field, type the IP address or hostname of the McAfee Vulnerability Manager that
contains the vulnerabilities you want to retrieve with the SOAP API.

For example, https://foundstone IP address:SOAP port. The default value is https://localhost:3800.

8. In the Customer Name field, type the name of the customer that belongs to the user name.

9. In the User Name field, type the user name to access McAfee Vulnerability Manager.

10. In the Client IP Address field, type the IP address of the server that you want to perform the scan.

TIP: This field is typically not used; however, it may be required for you to validate some scan
environments.

11. In the Password field, type the password to access McAfee Vulnerability Manager.

12. In the Configuration Name field, type the scan configuration name that exists in McAfee Vulnerability
Manager and to which the user has access.

Make sure that this scan configuration is active or runs frequently.

13. In the CA Truststore field, type the directory path and filename for the CA truststore file.

The default path is /opt/qradar/conf/mvm.keystore.

14. In the CA Keystore field, type the directory path and filename for the client keystore.

The default path is /opt/qradar/conf/mvm.truststore.

15. From theMcAfee Vulnerability Manager Version list, select the software version of your McAfee
Vulnerability Manager.
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16.To remove previously detected vulnerabilities that were not detected by the most recent scan, select
the Vulnerability Cleanup check box.

17. To configure a CIDR range for the scanner:

a. Type the CIDR range for the scan or click Browse to select a CIDR range from the network list.

The McAfee Vulnerability Manager accepts only CIDR addresses ranges to a 0/0 subnet that are
added as 0.0.0.0/0.

b. Click Add.

18.Click Save.

19.On the Admin tab, click Deploy Changes.

You are now ready to create certificates from McAfee Vulnerability Manager. See “Creating Certificates
for McAfee Vulnerability Manager” on page 86.
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Creating Certificates for McAfee Vulnerability
Manager

To connect through the FoundstoneOpenAPI, configure third-party certificateswith theMcAfeeCertificate
Manager Tool.

If the Certificate Manager Tool is not installed on the McAfee Foundstone Enterprise Manager server,
contact McAfee Technical Support.

You must process client-side certificates into valid keystore and truststore files for JSA on the McAfee
Foundstone Enterprise Manager server.

The McAfee Foundstone Enterprise Manager server must be compatible with the version of the
FIPS-Capable OpenSSL used by the Foundstone Certificate Manager to correctly create the certificates.
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A Java Software Development Kit (Java SDK) must be present on this server for this processing. To obtain
the most recentJava SDK go to the following website:

http://java.sun.com.

1. Log in to the McAfee Foundstone Enterprise Manager server.

2. Run the Foundstone Certificate Manager.

3. Click the Create SSL Certificates tab.

4. Type the host address for JSA.

The certificate must be created with the host address for the JSA appliance that retrieves vulnerability
data from the McAfee Vulnerability Manager.

5. Optional: Click Resolve.

If an error occurs when the Foundstone Certificate Manager attempts to resolve the host, type the IP
address in the Host Address field . If the host cannot resolve, see Step 7.

6. Click Create Certificate Using Common Name.

7. Click Create Certificate Using Host Address.

8. Save the compressed file that contains the certificate files to a directory on your McAfee Vulnerability
Manager.

9. Copy the pass phrase that is provided to a text file.

10.Repeat this process to generate any more certificates for managed hosts in your deployment.

You are now ready to process the certificates to create the required keystore and truststore files. See
“Processing Certificates for McAfee Vulnerability Manager” on page 88.
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Processing Certificates for McAfee Vulnerability
Manager

To create the keystore and truststore files required by JSA, process the certificates that Foundstone
Certificate Manager created.

Youmust have access to the support portal to download the files that are required to create the truststore
and keystore files. The batch files require the path to the Java home directory on theMcAfee Vulnerability
Manager.

1. Log in to the support portal to download the following files:

• VulnerabilityManager-Cert.bat.gz

• q1labs_vis_mvm_cert.jar

2. Extract the compressed files and copy the certificates and the downloaded files to the same directory
on your McAfee Vulnerability Manager.

3. Open the command-line interface on the McAfee Vulnerability manager.

4. Go to the directory location of the files.

5. To run the batch file, type the following command: VulnerabilityManager-Cert.bat "C:\Program
Files\Java\jdk1.6.0_20".

The quotation marks in the command specify the Java home directory.

6. Repeat this process to create keystore and truststore files for any more managed hosts in your
deployment.

The keystore and truststore files are created. If an error is displayed, administrators can verify the path to
the Java home directory.

You are now ready to import the certificates for your JSA appliance. See “Importing Certificates forMcAfee
Vulnerability Manager” on page 89
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Importing Certificates for McAfee Vulnerability
Manager

The keystore and truststore files must be imported to the managed host responsible for the scan.

You must add the scanner to a managed host in the scan configuration before you import the certificates.
For security purposes, a secure file transfer protocol to copy a certificate file.

1. To import the certificates, secure copy the mvm.keystore and mvm.truststore files to the following
directories in JSA:

• /opt/qradar/conf/

• /opt/qradar/conf/trusted_certificates/

NOTE: If the /opt/qradar/conf/trusted_certificates/ directory does not exist, do not create
the directory. If the directory does not exist, administrators can ignore the file copy for the
missing directory.

If you have a distributed deployment, you must copy the files to the Console and SSH the files from
the Console appliance to the managed host.

2. Log in to JSA.

3. Click the Admin tab.

4. On the Admin tab, select Advanced > Deploy Full Configuration.

NOTE: When you click Deploy Full Configuration, JSA restarts all services. Service restart
results in a gap in data collection for events and flows until the deployment process completes.

5. Repeat the certificate import for anymoremanaged hosts in your deployment that collect vulnerabilities
from McAfee Vulnerability Manager.
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Microsoft SCCM Scanner Overview

JSA imports scan reports from Microsoft System Center Configuration Manager (SCCM) scanners.

The Microsoft SCCM scanner collects the following information:

• Asset information

• name

• NetBIOS name, OS and version

• IP addresses

• MAC addresses

• Installed patches

• Pending patches

NOTE: Pending patches might or might not have a vulnerability reference.

To integrate a Microsoft SCCM scanner, complete the following steps:

1. On your Microsoft SCCM scanner, configure WMI enablement.

2. If automatic updates are not enabled on your JSA console, download and install the Microsoft SCCM
RPM.

3. On your JSA console, add a Microsoft SCCM scanner.

4. On your JSA console, create a scan schedule to import scan result data.
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Enable WMI for Microsoft SCCM Scanners

Before you configure a Microsoft SCCM scanner, configure your system DCOM settings for each host
that you want to monitor.

The scanner host must meet the following conditions:

• You are a member of the Administrators group on that host.

• One of the following operating systems is installed:

• Windows 7

• Windows 2008

• Windows 2008 R2

• Windows 2012

• Windows 2012 R2 (only 64 bit is supported)

• Vista software

NOTE: SCCM is not supported on versions of Windows that were moved to End of Life by
Microsoft. If a software version date is beyond the Extended Support End Date, the product might
not function as expected. Juniper does not make code or vulnerability fixes to resolve issues for
older operating systems. For example,MicrosoftWindows Server 2003R2 andMicrosoftWindows
XP are operating systems that are beyond the Extended Support End Date. Any questions about
this announcement can be discussed in the JSA forums. For more information about support
lifecycles, see the Microsoft Support lifecycle website
(https://support.microsoft.com//en-us/lifecycle/search)

• DCOM is configured and enabled.

If a firewall is installed on the host or is located between the host and JSA, such as a hardware or other
intermediary firewall, the firewall must be configured to allow DCOM communication. Configure the
firewall to allow port 135 to be accessible on the host, and allow DCOMports. DCOM ports are random
ports above 1024. Depending on your version of Windows, you might need to configure specific ports
to be accessible to DCOM. For more information, see your Windows documentation.

• Windows Management Instrumentation (WMI) is enabled.

• The remote registry service is activated.
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Adding a Microsoft SCCM Scanner | 95

Adding a Microsoft SCCM Scanner

Ensure that WMI is enabled on your scanner host.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. Configure the following Microsoft SCCM parameters:

DescriptionParameter

The name to identify your scanner instance.Scanner Name

The managed host from your JSA deployment that
manages the scanner import.

Managed Host

Microsoft SCCMType

The IP address or host name of the remote server that
hosts the scan result files.

Host Name

The domain that is used to connect to the remote server.Domain

5. Configure the remaining parameters.

6. To configure a CIDR range for your scanner, complete the following steps:

a. Type the CIDR range that you want this scanner to consider or click Browse to select a CIDR range
from the network list.

b. Click Add.

7. Click Save.
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nCircle IP360 Scanner Overview

JSA supports both nCircle and Tripwire versions of the IP360 scanner. Administrators can import XML2
scan reports from SSH servers that contain IP360 vulnerability information.

JSA cannot connect directly with nCircle devices. You can configure an nCircle IP360 scanner device to
export scan results in XML2 format to a remote SSH server. To import the most recent scan results from
the remote server to JSA, you can schedule a scan or poll the remote server for updates to the scan results.

The scan results contain identification information about the scan configuration fromwhich it was produced.
The most recent scan results are used when JSA imports a scan. JSA supports exported scan results only
from the IP360 scanner in XML2 format.

To integrate an nCircle IP360 scanner, perform the following steps:

1. On your nCircle IP360 scanner, configure your nCircle scanner to export scan reports. See “Exporting
nCircle IP360 Scan Results to an SSH Server” on page 99.

2. On your JSA Console, add an nCircle IP360 scanner. See “Adding a nCircle IP360 Scanner” on page 100

3. On your JSA Console, create a scan schedule to import scan result data. See“Scheduling a Vulnerability
Scan” on page 195

Exporting nCircle IP360 ScanResults to an SSHServer

JSA uses an automated export function to publish XML2 scan data from nCircle IP360 appliances. JSA
supports VnE Manager version IP360-6.5.2 to 6.8.2.8.

Ensure that the remote server is a UNIX system with SSH enabled.

1. Log in to the IP360 VNE Manager user interface.

2. From the navigation menu, select Administer > System > VNE Manager > Automated Export.

3. Click the Export to File tab.

4. Configure the export settings.

The export must be configured to use the XML2 format.

5. Record the target settings that are displayed in the user interface for the scan export. These settings
are necessary to configure JSA to integrate with your nCircle IP360 device.
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Adding a nCircle IP360 Scanner

JSA uses a Secure Shell (SSH) to access a remote server (SSH export server) to retrieve and interpret the
scan data from nCircle IP360 appliances. JSA supports VnE Manager version IP360-6.5.2 to 6.8.2.8.

This configuration requires the target settings that you recorded when you exported the XML2 scan data
to the remote server.

If the scanner is configured to use a password, the SSH scanner server towhich JSA connectsmust support
password authentication. If it does not, SSH authentication for the scanner fails. Make sure the following
line is displayed in your sshd_config file, which is typically found in the /etc/ssh directory on the SSH
server: PasswordAuthentication yes. If your scanner server does not use OpenSSH, the configuration can
differ. For more information, see the vendor documentation for your scanner.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. Configure the following nCircle IP360 parameters:

DescriptionParameter

The name to identify your nCircle IP360 instance.Scanner Name

The managed host from your JSA deployment that
manages the scanner import.

Managed Host

nCircle IP360Type

The IP address or host name of the remote server that
hosts the scan result files.

SSH Server Host Name

The port number to connect to the remote server.SSH Port

The location of the scan result files.Remote Directory
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DescriptionParameter

The regular expression (regex) to filter the list of files that
are specified in the Remote Directory field. To list all
XML2 format files that end with XML, use the following
entry: XML2.*\.xml

File Pattern

5. Configure the remaining parameters.

6. To configure a CIDR range for your scanner:

a. Type the CIDR range that you want this scanner to consider or click Browse to select a CIDR range
from the network list.

b. Click Add.

7. Click Save.

8. On the Admin tab, click Deploy Changes.
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Nessus Scanner Overview

JSA can use a Nessus client and server relationship to retrieve vulnerability scan reports. You can also use
the Nessus XMLRPC API or JSON API to access scan data directly from Nessus.

When you configure your Nessus client, you need to create a Nessus user account for your JSA system.
A unique user account ensures that JSA has the correct credentials to log in and communicate with the
Nessus server. After you create the user account, a connection test verifies the user credentials and remote
access.

NOTE: Do not install Nessus software on a critical system due to the CPU requirements when
scans are active.

Data Collection Options

The following options are available for data collection of vulnerability information from Nessus scanners:

• Scheduled Live Scan--Live scans enable predefined scans to be started remotely over SSH in Nessus
and the data is imported at the completion of the scan.

• Scheduled Results Import--Static result files from completed scans are imported from a repository over
SSH that contains the Nessus scan results.

• Scheduled Live Scan - XMLRPC API--The XMLRPC enables predefined scans to be started remotely
and actively collected by using XMLRPC API.

The Nessus XMLRPC API is only available on Nessus servers and clients with software V4.2 - V5.x.

• Scheduled Live Scan - JSONAPI --Enables predefined scans to be started remotely and actively collected
by using JSON API.

The JSON API is not available on Nessus servers and clients with software versions earlier than V6.0.

• Scheduled Completed Report Import - XMLRPC API--Enables completed reports to be imported from
the Nessus server using XMLRPC API.

The Nessus XMLRPC API is only available on Nessus servers and clients with software V4.2 - V5.x.

• Scheduled Completed Report Import - JSON API--Enables completed reports to be imported from the
Nessus server.

The JSON API is not available on Nessus servers and clients with software versions earlier than V6.0.
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Server Certificates

Before you add a scanner, a server certificate is required to support HTTPS connections. JSA supports
certificates with the following file extensions: .crt, .cert, or .der. To copy a certificate to the
/opt/qradar/conf/trusted_certificates directory, choose one of the following options:

• Manually copy the certificate to the /opt/qradar/conf/trusted_certificates directory by using Secure
Copy (SCP) or Secure File Transfer Protocol (SFTP).

• To automatically download the certificate to the/opt/qradar/conf/trusted_certificates directory, SSH
into the Console or managed host and type the following command:

/opt/qradar/bin/getcert.sh <IP_or_Hostname> <optional_port_(443_default)>
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Adding a Nessus Scheduled Live Scan

A live scan runs on your Nessus server and imports the result data from a temporary directory on the
Nessus client that contains the scan report data.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify your Nessus scanner.

5. From theManaged Host list, select the managed host that manages the scanner import.

6. From the Type list, select Nessus Scanner.

7. From the Collection Type list, select Scheduled Live Scan.
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8. Configure the following parameters:

DescriptionParameter

The user name to access Nessus server.Server Username

Your Nessus server password must not contain the
exclamation mark (!) character or authentication failures
can occur over SSH.

Server Password

The directory path of the Nessus client that JSA can use
to store temporary files.

JSA uses the temporary directory on the Nessus client to
upload scan targets and read scan results. Temporary files
are removed from the temporary directory when the scan
completes and the scan report is downloaded.

Client Temp Dir

The directory path to the executable file on the Nessus
server.

Nessus Executable

The directory path to the Nessus configuration file on the
Nessus client.

Nessus Configuration File

The host name or IP address of the Nessus client.Client Hostname

The SSH port on the Nessus server that can be used to
retrieve scan result files.

Client SSH Port

The user name to authenticate the SSH connection.Client Username

If the Enable Key Authentication field is enabled, the
password is ignored.

If the scanner is configured to use a password, the SSH
scanner server that connects to JSA must support
password authentication. If it does not, SSH authentication
for the scanner fails. Ensure the following line is displayed
in your /etc/ssh/sshd_config file:PasswordAuthentication
yes. If your scanner server does not use OpenSSH, see
the vendor documentation for the scanner configuration
information.

Client Password

The directory path to the key file. If a key file does not
exist, you must create the vis.ssh.key file.

Private Key File
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DescriptionParameter

The size of the subnet that you want to scan. The value
represents the largest portion of the subnet the scanner
can scan at one time. The mask segments the scan to
optimize the scan performance.

CIDR Mask

9. To configure a CIDR range for your scanner:

a. Type the CIDR range that you want this scanner to consider or click Browse to select a CIDR range
from the network list.

b. Click Add.

10.Click Save.

11.On the Admin tab, click Deploy Changes.
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Adding a Nessus Scheduled Result Import

A scheduled results import retrieves completed Nessus scan reports from an external location.

A completed scan report can be stored on a Nessus server or a file repository. JSA connects to the Nessus
server or file repository by using SSH and then imports completed scan report files. The reports are filtered
by a defined regular expression or maximum report age. JSA supports imports of Nessus scan reports in
.nessus format or scan reports that are exported to a Nessus output format, such as XML2.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.
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4. In the Scanner Name field, type a name to identify your Nessus scanner.

5. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.

6. From the Type list, select Nessus Scanner.

7. From the Collection Type list, select Scheduled Results Import.

8. In the Remote Results Hostname field, type the IP address or hostname of the Nessus client or server
that hostsyour Nessus or XML2 scan result files.

9. Choose one of the following authentication options:

DescriptionOption

To authenticate with a user name and password:

1. In the SSH Username field, type the user name to
access the Nessus scanner or the repository that hosts
the scan result files.

2. In the SSH Password field, type the password that is
associated with the user name.

The password must not contain the exclamation mark (!)
character. This character might cause authentication
failures over SSH.

Login Username

To authenticate with a key-based authentication file:

1. Select the Enable Key Authentication check box.

2. In the Private Key File field, type the directory path
to the key file.

The default directory for the key file
is/opt/qradar/conf/vis.ssh.key. If a key file does not exist,
you must create the vis.ssh.key file.

Enable Key Authorization

10. In the Remote Results Directory field, type the directory location of the scan result files.

The default directory path is ./.

11. In the File Name Pattern field, type a regular expression (regex) to filter the list of files that are specified
in the Remote Directory. All matching files are included in the processing.
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By default, the Report Name Pattern field contains .*\.nessus as the regex pattern. The .*\.nessus
pattern imports all Nessus formatted result files in the remote directory.

12. In theMax Reports Age (Days) field, type the maximum file age for your scan results file.

Files that are older than the specified days and time stamp on the report file are excluded when the
schedule scan starts. The default value is 7 days.

13. To configure a CIDR range for your scanner:

a. In the text field, type the CIDR range that you want this scanner to consider or click Browse to
select a CIDR range from the network list.

b. Click Add.

14.Click Save.
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Adding a Nessus Live Scan with the XMLRPC API

JSA can use the XMLRPC API to start a pre-configured scan that is based on a scan name and optional
policy name on the Nessus server.

To start a live scan from JSA, you must specify the scan name and the policy name for the live scan data
you want to retrieve. As the live scan progresses, you can point your mouse over the Nessus scanner in
the Scan Scheduling window to view the percentage of the live scan that is complete. After the live scan
reaches completion, JSA uses the XMLRPC API to retrieve the scan data and update the vulnerability
information for your assets.

The Nessus XMLRPC API is only available on Nessus servers and clients with software v4.2 to v5.0.

1. Click the Admin tab.

2. Click the VA Scanners icon.
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3. Click Add.

4. In the Scanner Name field, type a name to identify your Nessus scanner.

5. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.

6. From the Type list, select Nessus Scanner.

7. From the Collection Type list, select Scheduled Live Scan - XMLRPC API.

8. Configure the following parameters:

DescriptionParameter

The IP address or host name of the Nessus server.Hostname

The port number the Nessus server.Port

The user name that is required to access to access Nessus
server

Username

Your Nessus server password must not contain the
exclamation mark (!) character or authentication failures
can occur over SSH.

Password

The name of the scan you want displayed when the live
scan runs on the Nessus server.

If this field is clear, the API attempts to start a live scan
for JSA Scan. This field does not support by using the
ampersand (&) character in this field.

Scan Name

The name of a policy on your Nessus server to start a live
scan.

The policy must exist on the Nessus server when the
system attempts to start the scan. If the policy does not
exist, an error is displayed in the Status column. Systems
can have custom policy names, but several default policy
names are included. External Network Scan, Internal
Network Scan,Web App Tests, Prepare for PCI DSS
audits are default policy names.

Policy Name
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9. To configure a CIDR range for your scanner:

a. In the text field, type the CIDR range that you want this scanner to consider or click Browse to
select a CIDR range from the network list.

b. Click Add.

10.Click Save.
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Adding a Nessus Completed Report Import with the
XMLRPC API

A scheduled results import using the XMLRPCAPI enables completed vulnerability reports to be downloaded
from the Nessus server.

JSA connects to your Nessus server and downloads data from any completed reports matching the report
name and maximum report age filter. The Nessus XMLRPC API is available on Nessus servers and clients
using software v4.2 - V5.x.

1. Log in to JSA as an administrator.

2. Click the Admin tab.

3. Click the VA Scanners icon.

4. Click Add.

5. In the Scanner Name field, type a name to identify your Nessus server.

6. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.
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7. From the Type list, select Scheduled Completed Report Import - XMLRPC AP.

8. In the Hostname field, type the IP address or hostname of the Nessus Server containing the
vulnerabilities you want to retrieve with the Nessus XMLRPC API.

9. In the Port field, type the port number the Nessus server.

The default API port value is 8834 .

10. In the Username field, type the username required to access the Nessus server.

11. In the Password field, type the password required to access the Nessus server.

12. In the Report Name Pattern field, type a regular expression (regex) required to filter the list of files
specified in the Remote Directory. All matching files are included in the processing.

By default, the Report Name Pattern field contains .* as the regex pattern. The .* pattern imports all
nessus formatted result files in the remote directory.

13. In theMax Reports Age (Days) field, type the maximum file age for your scan results file.

Files that are older than the specified days and timestamp on the report file are excluded when the
schedule scan starts. The default value is 7 days.

14. To configure a CIDR range for your scanner:

a. In the text field, type the CIDR range you want this scanner to consider or click Browse to select a
CIDR range from the network list.

b. Click Add.

15.Click Save.
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Adding a Nessus Live Scan with the JSON API

JSA can use the JSON API to start a pre-configured scan that is based on a scan name and optional policy
name on the Nessus server.

To start a live scan from JSA, you must specify the scan name and the policy name for the live scan data
you want to retrieve. As the live scan progresses, you can point your mouse over the Nessus scanner in
the Scan Scheduling window to view the percentage of the live scan that is complete. After the live scan
reaches completion, JSA uses the JSON API to retrieve the scan data and update the vulnerability
information for your assets.

The Nessus JSON API is only available on Nessus servers and clients with software v6.0 and later.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify your Nessus scanner.

5. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.

6. From the Type list, select Nessus Scanner.

7. From the Collection Type list, select Scheduled Live Scan - JSON API.

8. Configure the following parameters:

DescriptionParameter

The IP address or host name of the Nessus server.Hostname

The port number the Nessus server.Port

The user name that is required to access Nessus server.Username

Your Nessus server password must not contain the
exclamation mark (!) character or authentication failures
can occur.

Password
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DescriptionParameter

The name of the scan you want displayed when the live
scan runs on the Nessus server.

If this field is clear, the API attempts to start a live scan
for JSA Scan. This field does not support by using the
ampersand (&) character in this field.

Scan Name

The name of a policy on your Nessus server to start a live
scan.

The policy must exist on the Nessus server when the
system attempts to start the scan. If the policy does not
exist, an error is displayed in the Status column. Systems
can have custom policy names, but several default policy
names are included. External Network Scan, Internal
Network Scan,Web App Tests, Prepare for PCI DSS
audits are default policy names.

Policy Name

If there is more than one Nessus scanner in your
deployment, specify the name of the scanner that you
want to run scans on.

Scanner Name

9. To configure a CIDR range for your scanner:

a. In the text field, type the CIDR range that you want this scanner to consider or click Browse to
select a CIDR range from the network list.

b. Click Add.

10.Click Save.
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Adding a Nessus Completed Report Import with the
JSON API

A scheduled results import retrieves completed Nessus scan reports from an external location by using
the JSON API.

A completed scan report can be stored on a Nessus server or a file repository. JSA connects to the Nessus
server or file repository by using the JSON API and then imports completed scan report files. The reports
are filtered by a defined expression or maximum report age.

The Nessus JSON API is only available on Nessus servers and clients with software v6.0 and higher.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify your Nessus scanner.

5. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.

6. From the Type list, select Nessus Scanner.

7. From the Collection Type list, select Scheduled Completed Report Import - JSON API.

8. Configure the following parameters:

DescriptionParameter

The IP address or host name of the Nessus server.Hostname

The port number the Nessus server.Port

The user name that is required to access Nessus serverUsername

Your Nessus server password.Password

116



DescriptionParameter

FIlters the list of files that are specified in the Remote
Directory. All matching files are included in the processing.
By default, the Report Name Pattern field contains .* as
the filter.

Report Name Filter

The maximum file age for your scan results file. Files that
are older than the specified days and time stamp on the
report file are excluded when the schedule scan starts.
The default value is 7 days.

Report Max Age (days)

9. To configure a CIDR range for your scanner:

a. In the text field, type the CIDR range that you want this scanner to consider or click Browse to
select a CIDR range from the network list.

b. Click Add.

10.Click Save.
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netVigilance SecureScout Scanner Overview

JSA can collect vulnerability data from an SQL database on the SecureScout scanner by polling for data
with JDBC.

netVigilance SecureScout NX and SecureScout SP store scan results in an SQL database. This database
can be a Microsoft MSDE or SQL Server database. To collect vulnerabilities, JSA connects to the remote
database to locate the latest scan results for a given IP address. The data returned updates the asset profile
in JSAwith the asset IP address, discovered services, and vulnerabilities. JSA supports SecureScout scanner
software version 2.6.

We suggest that administrators create a special user in your SecureScout database for JSA to poll for
vulnerability data.

The database user you create must have select permissions to the following tables:

• HOST

• JOB

• JOB_HOST

• SERVICE

• TCRESULT

• TESTCASE

• PROPERTY

• PROP_VALUE

• WKS

• IPSORT - The database user must have execute permission for this table.

To add a scanner configuration, see“Adding a NetVigilance SecureScout Scan” on page 121.

Adding a NetVigilance SecureScout Scan

Administrators can add a SecureScout scanner to query for vulnerability data with JDBC.

To query for vulnerability data, JSA youmust have appropriate administrative access to poll the SecureScout
scannerwith JDBC. Administratorsmust also ensure that firewalls, including the firewall on the SecureScout
host permits a connection from the managed host responsible for the scan to the SecureScout scanner.
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1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify your SecureScout server.

5. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.

6. From the Type list, select SecureScout Scanner.

7. In the Database Hostname field, type the IP address or hostname of the SecureScout database server
that contains the SQL server.

8. In the Login Name field, type the username required to access the SQL database of the SecureScout
scanner.

9. Optional. In the Login Password field, type the password required to access the SQL database of the
SecureScout scanner.

10. In the Database Name field, type SCE.

11. In theDatabase Port field, type the TCP port you want the SQL server to monitor for connections. The
default value is 1433.

12. To configure a CIDR range for your scanner:

a. In the text field, type the CIDR range you want this scanner to consider or click Browse to select a
CIDR range from the network list.

b. Click Add.

13.Click Save.

14.On the Admin tab, click Deploy Changes.

You are now ready to create a scan schedule. See “Scheduling a Vulnerability Scan” on page 195.

RELATED DOCUMENTATION

122



netVigilance SecureScout Scanner Overview | 121

123



16
CHAPTER

NMap Scanner Overview

NMap Scanner Overview | 127

Adding a NMap Remote Result Import | 127

Adding a NMap Remote Live Scan | 130





NMap Scanner Overview

JSA uses SSH to communicate with the NMap server to either start remote NMap scans or download the
completed NMap scan results.

NOTE: Although there is an NMap binary on each JSA host, it is reserved for internal JSA use only.
Configuring anNMap vulnerability scanner to use a JSA console or JSAmanaged host as the remote
NMap scanner is not supported and can cause instabilities.

When administrators configure an NMap scan, a specific NMap user account can be created for the JSA
system. A unique user account ensures that JSA possesses the credentials that are required to log in and
communicate with the NMap server. After the user account creation is complete, administrators can test
the connection from JSA to the NMap client with SSH to verify the user credentials. This test ensures that
each system can communicate before the system attempt to download vulnerability scan data or start a
live scan.

The following options are available for data collection of vulnerability information from NMap scanners:

• Remote live scan. Live scans use the NMap binary file to remotely start scans. After the live scan
completes, the data is imported over SSH. See “Adding a NMap Remote Live Scan” on page 130.

• Remote results import. The result data from a previously completed scan is imported over SSH. See
“Adding a NMap Remote Result Import” on page 127.

Adding a NMap Remote Result Import

A remote results import retrieves completed NMap scan reports over SSH.

Scans must be generated in XML format by using the -oX option on your NMap scanner. After you add
your NMap scanner, you must assign a scan schedule to specify the frequency that the vulnerability data
is imported from scanner.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.
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4. In the Scanner Name field, type a name to identify your NMap scanner.

5. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.

6. From the Type list, select Nessus Scanner.

7. From the Collection Type list, select Remote Results Import.

8. In the Server Hostname field, type the host name or IP address of the remote system that hosts the
NMap client. Adminitrators should host NMap on a UNIX-based system with SSH enabled.

9. Choose one of the following authentication options:

DescriptionOption

To authenticate with a user name and password:

1. In the Server Username field, type the user name that
is required to access the remote system that hosts
NMap client.

2. In the Login Password field, type the password that
is associated with the user name.

The password must not contain the ! character. This
character might cause authentication failures over SSH.

If the scanner is configured to use a password, the SSH
scanner server to that connects to JSA must support
password authentication.

If it does not, SSH authentication for the scanner fails.
Ensure the following line is displayed in your
/etc/ssh/sshd_config file: PasswordAuthentication yes.

If your scanner server does not use OpenSSH, see the
vendor documentation for the scanner configuration
information.

Login Username
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DescriptionOption

To authenticate with a key-based authentication file:

1. Select the Enable Key Authentication check box.

2. In the Private Key File field, type the directory path
to the key file.

The default directory for the key file
is/opt/qradar/conf/vis.ssh.key. If a key file does not exist,
you must create the vis.ssh.key file.

Enable Key Authorization

10. In the Remote Folder field, type the directory location of the scan result files.

Linux example: /home/scans

Windows example: /c:/zenmap

11. In the Remote File Pattern field, type a regular expression (regex) that is required to filter the list of
files that are specified in the remote folder. All matching files are included in the processing.

The default regex pattern to retrieve NMap results is .*\.xml. The .*\.xml pattern imports all xml result
files in the remote folder.

Scan reports imported and processed are not deleted from the remote folder. You should schedule a
cron job to delete previously processed scan reports.

12. To configure a CIDR range for your scanner:

a. In the text field, type the CIDR range that you want this scanner to consider or click Browse to
select a CIDR range from the network list.

b. Click Add.

13.Click Save.

14.On the Admin tab, click Deploy Changes.

You are now ready to create a scan schedule. See “Scheduling a Vulnerability Scan” on page 195
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Adding a NMap Remote Live Scan

JSA monitors the status of the live scan in progress and waits for the NMap server to complete the scan.
After the scan completes, the vulnerability results are downloaded over SSH.

Several types of NMap port scans require NMap to run as a root user. Therefore, JSA must have access
as root or you must clear the OS Detection check box. To run NMap scans with OS Detection enabled,
youmust provide root access credentials to JSAwhen you add the scanner. Alternately, you can have your
administrator configure the NMap binary with setuid root. See your NMap administrator for more
information.

NOTE: Although there is an NMap binary on each JSA host, it is reserved for internal JSA use only.
Configuring anNMap vulnerability scanner to use a JSA console or JSAmanaged host as the remote
NMap scanner is not supported and can cause instabilities.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify your NMap scanner.

5. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.

6. From the Type list, select NMap Scanner.

7. From the Scan Type list, select Remote Live Scan.

8. In the Server Hostname field, type the IP address or hostname of the NMap server.
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9. Choose one of the following authentication options:

DescriptionOption

To authenticate with a user name and password:

1. In the Server Username field, type the username
required to access the remote system hosting the
NMap client using SSH.

2. In the Login Password field, type the password
associated with the user name.

If the OS Detection check box is selected, the username
must have root privileges.

Server Username

To authenticate with a key-based authentication file:

1. Select the Enable Key Authentication check box.

2. In the Private Key File field, type the directory path
to the key file.

The default is directory for the key file
is/opt/qradar/conf/vis.ssh.key. If a key file does not exist,
you must create the vis.ssh.key file.

If the scanner is configured to use a password, the SSH
scanner server to that connects to JSA must support
password authentication.

If it does not, SSH authentication for the scanner fails.
Ensure the following line is displayed in your
/etc/ssh/sshd_config file: PasswordAuthentication yes.

If your scanner server does not use OpenSSH, see the
vendor documentation for the scanner configuration
information.

Enable Key Authorization

10. In the NMap Executable field, type the full directory path and filename of the NMap binary file.

The default directory path to the binary file is /usr/bin/NMap.

11. Select an option for the Disable Ping check box.

In some networks, the ICMP protocol is partially or completely disabled. In situations where ICMP is
not enabled, you can select this check box to disable ICMP pings to enhance the accuracy of the scan.
By default, the check box is clear.

12. Select an option for the OS Detection check box:
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• Select this check box to enable operating system detection in NMap. You must provide the scanner
with root privileges to use this option.

• Clear this check box to receive NMap results without operating system detection.

13. From theMax RTT Timeout list, select a timeout value.

The timeout value determines if a scan should be stopped or reissued due to latency between the
scanner and the scan target. The default value is 300 milliseconds (ms). If you specify a timeout period
of 50 milliseconds, then we suggest that the devices that are scanned be in the local network. Devices
in remote networks can use a timeout value of 1 second.

14. Select an option from the Timing Template list. The options include:

• Paranoid - This option produces a slow, non-intrusive assessment.

• Sneaky - This option produces a slow, non-intrusive assessment, but waits 15 seconds between scans.

• Polite - This option is slower than normal and intended to ease the load on the network.

• Normal - This option is the standard scan behavior.

• Aggressive - This option is faster than a normal scan and more resource intensive.

• Insane - This option is not as accurate as slower scans and only suitable for very fast networks.

15. In the CIDR Mask field, type the size of the subnet scanned.

The value specified for the mask represents the largest portion of the subnet the scanner can scan at
one time. The mask segments the scan to optimize the scan performance.

16. To configure a CIDR range for your scanner:

a. In the text field, type the CIDR range you want this scanner to consider or click Browse to select a
CIDR range from the network list.

b. Click Add.

17.Click Save.

18.On the Admin tab, click Deploy Changes.

You are now ready to create a scan schedule. See “Scheduling a Vulnerability Scan” on page 195
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Outpost24 Vulnerability Scanner Overview

JSA uses HTTPS to communicate with the Outpost24 vulnerability scanner API to download asset and
vulnerability data from previously completed scans.

The following table lists the specifications for the Outpost24 vulnerability scanner:

Table 5: Outpost24 Vulnerability Scanner Specifications

ValueSpecification

Outpost24 Vulnerability ScannerScanner name

HIAB V4.1

OutScan V4.1

Supported versions

HTTPSConnection type

Outpost24 website (http://www.outpost24.com/)More information

Server Certificates

Before you add a scanner, a server certificate is required to support HTTPS connections. JSA supports
certificates with the following file extensions: .crt, .cert, or .der. To copy a certificate to the
/opt/qradar/conf/trusted_certificates directory, choose one of the following options:

• Manually copy the certificate to the /opt/qradar/conf/trusted_certificates directory by using Secure
Copy (SCP) or Secure File Transfer Protocol (SFTP).

• To automatically download the certificate to the/opt/qradar/conf/trusted_certificates directory, SSH
into the Console or managed host and type the following command:

/opt/qradar/bin/getcert.sh <IP_or_Hostname> <optional_port_(443_default)>

Install the Java Cryptography Extension

The default certificates that are used by OUTSCAN and HIAB use 2048-bit keys. As a result, you must
modify the Java cryptography when you use these certificates. For more information, see “Installing the
Java Cryptography Extension on JSA” on page 17.
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Configuration Steps

To configure JSA to download asset and vulnerability data from an Outpost24 vulnerability scanner,
complete the following steps:

1. If automatic updates are not enabled, download and install the most recent version of the Outpost24
Vulnerability Scanner RPM on your JSA system.

2. On the Outpost24 vulnerability scanner, create an application token for JSA.

3. On the JSA Console, add the Outpost24 vulnerability scanner. Configure all required parameters and
use the following table to identify specific Outpost24 values:

Table 6: Outpost24 Vulnerability Scanner Parameters

ValueParameter

Outpost24 Vulnerability ScannerType

The host name or IP address of the Outpost24
vulnerability scanner device.

Server Hostname

443Port

Must use theAPI token that you created on theOutpost24
vulnerability scanner device.

API token

4. Schedule a scan.

Creating an Outpost24 API Authentication Token for
JSA

To enable JSA to use the Outpost24 API to download asset and vulnerability data, create an Application
Access Token on the Outpost24 vulnerability scanner.

1. Log in to Outpost24 vulnerability scanner.

2. Select >Settings > Account.

3. Click the Security Policy tab.
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4. In the Application Access Tokens pane, click New.

5. In theMaintaining App Access Token window, ensure that the Active check box is selected.

6. Type a name for the application, for example, JSA.

7. Configure the IP restrictions and user access rights.

8. Click Save.

9. Copy the 64 character authentication token to a file.

On your JSA system, add the Outpost24 vulnerability scanner.
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Positive Technologies MaxPatrol

You can add a Positive Technologies MaxPatrol scanner to your JSA deployment.

At intervals that are determined by a scan schedule, JSA imports XML file results that contain MaxPatrol
vulnerabilities. The MaxPatrol scanner imports files from a remote server that contains the exported scan
data.

The following table provides Positive Technologies MaxPatrol scanner details:

Table 7: Positive Technologies MaxPatrol Scanner Details

Positive TechnologiesVendor

MaxPatrolScanner name

V8.24.4 and laterSupported versions

Use the following procedures to integrate Positive Technologies MaxPatrol with JSA

1. Configure your Positive Technologies MaxPatrol scanner to export scan reports. Enable the JSA
compatible XML file vulnerability exports. To obtain the necessary files and configuration procedures,
contact Positive Technologies Customer Support.

2. On your JSA Console, add a Positive Technologies MaxPatrol scanner.

3. On your JSA Console, create a scan schedule to import scan result data.

Integrating Positive TechnologiesMaxPatrolwith JSA

Procedures that are required to integrate Positive Technologies MaxPatrol with JSA.

1. Configure your Positive Technologies MaxPatrol scanner to export scan reports. Enable the JSA
compatible XML file vulnerability exports. To obtain the necessary files and configuration procedures,
contact Positive Technologies Customer Support.

2. On your JSA Console, add a Positive Technologies MaxPatrol scanner.

3. On your JSA Console, create a scan schedule to import scan result data.
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Adding a Positive Technologies MaxPatrol Scanner

Add a Positive Technologies MaxPatrol scanner to your JSA deployment.

Ensure that the following prerequisites are met:

• The Positive Technologies MaxPatrol system is configured to export JSA compatible XML vulnerability
reports.

• An SFTP or SMB share is set up and contains the exported XML vulnerability reports.

The following table describes Positive Technologies MaxPatrol scanner parameters when you select SFTP
as the import method:

Table 8: Positive Technologies MaxPatrol Scanner SFTP Properties

DescriptionParameter

The IP address or host name of the server that has the
scan results file.

Remote Hostname

The user name that JSA uses to log in to the server.Login Username

Specifies that JSA authenticates with a key-based
authentication file.

Enable Key Authentication

The location of the scan result files.Remote directory

The full path to the file that contains the private key. If a
key file does not exist, you must create the vis.ssh.key
file.

Private Key File

The regular expression (regex) required to filter the list of
files in the Remote Directory. The .*\.xml pattern imports
all XML files in the remote directory.

File Name Pattern

The following table describes Positive Technologies MaxPatrol scanner parameters when you select SMB
Share as the import method:
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Table 9: Positive Technologies MaxPatrol Scanner SMB Share Properties

DescriptionParameter

The IP address or host name of the SMB Share.Hostname

The user name that JSA uses to log in to SMB Share.Login Username

The domain that is used to connect to the SMB Share.Domain

The full path to the share from the root of the SMB host.
Use forward slashes, for example, /share/logs/.

SMB Folder Path

The regular expression (regex) required to filter the list of
files in the Remote Directory. The .*\.xml pattern imports
all xml files in the remote directory.

File Name Pattern

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify the Positive Technologies MaxPatrol scanner.

5. From theManaged Host list, select the managed host that manages the scanner import.

6. From the Type list, select Positive Technologies MaxPatrol Scanner.

7. Configure the parameters.

8. Configure a CIDR range for the scanner.

9. Click Save.

10.On the Admin tab, click Deploy Changes.

For more information about how to create a scan schedule, see “Scheduling a Vulnerability Scan” on
page 195.
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Qualys Scanner Overview

JSA can retrieve vulnerability information from the QualysGuard Host Detection List API or download
scan reports directly from a QualysGuard appliance. You can integrate JSA with QualysGuard appliances
that use software version 4.7 through 8.1.

Qualys Detection Scanners

Add a Qualys Detection Scanner if you want to use the QualysGuard Host Detection List API to query
multiple scan reports to collect vulnerability data for assets. The data that the query returns contains the
vulnerabilities as identification numbers, which JSA compares against themost recentQualys Vulnerability
Knowledge Base. The Qualys Detection Scanner does not support live scans, but enables the Qualys
Detection Scanner to retrieve vulnerability information aggregated across multiple scan reports. JSA
supports key search parameters to filter for the information that youwant to collect. You can also configure
how frequently JSA retrieves and caches the Qualys Vulnerability Knowledge Base.

Qualys Scanners

Add a Qualys scanner if you want to import specific live or imported reports that include scan or asset
data. When you add a Qualys scanner, you can choose from the following collection types:

• Scheduled live - Scan Report

• Scheduled Import - Asset Data Report

• Scheduled Import - Scan Report
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Installing the Qualys Certificate

Before you can log in to Qualys, you must download the Qualys certificate into JSA.

A server certificate is required to support HTTPS connections. JSA supports certificates with the following
file extensions: .crt, .cert, or .der. Certificates can be manually copied to the
/opt/qradar/conf/trusted_certificates directory on JSA by using SCP or SFTP. However, you can also
download the Qualys certificate from a customer URL.

1. Contact Qualys for a customer URL and your login credentials. For more information about Qualys
login, see www.qualys.com/support (https://www.qualys.com/support/faq/login/).

2. Download the certificate by typing the following command:

/opt/qradar/bin/getcert.sh <customer_URL>

3. Copy the downloaded certificate to the /opt/qradar/conf/trusted_certificates directory.
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Adding a Qualys Detection Scanner

Add a Qualys detection scanner to use an API to query across multiple scan reports to collect vulnerability
data for assets. The Qualys detection scanner uses the QualysGuard Host Detection List API .

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify your Qualys detection scanner.
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5. From theManaged Host list, select the managed host that manages the scanner import.

6. From the Type list, select Qualys Detection Scanner.

7. Configure the following parameters:

DescriptionParameter

The Fully Qualified Domain Name (FQDN) or IP address
of the QualysGuard management console. If you type the
FQDN, the host name and not the URL, for example, type
qualysapi.qualys.com or qualysapi.qualys.eu.

Qualys Server Host Name

The user name that you specify must have access to
download the Qualys KnowledgeBase. For more
information about how to updateQualys subscription, see
your Qualys documentation.

Qualys Username

The password for your Qualys login.Qualys Password

The regular expression (regex) to filter the scan data by
the operating system.

Operating System Filter

A comma-separated list to query IP addresses by the asset
group name.

Asset Group Names

Host scan times that are older than the specified number
of days are excluded from the results that Qualys returns.

Host Scan Time Filter (Days)

The number of days that youwant JSA to store theQualys
Vulnerability Knowledge Base. If a scan is scheduled and
the retention period is expired, the system downloads an
update.

Qualys Vulnerability Retention Period (Days)

Forces the system to update to the Qualys Vulnerability
Knowledge Base for each scheduled scan.

Force Qualys Vulnerability Update

8. To configure a proxy, select theUse Proxy check box and configure the credentials for the proxy server.

9. To configure a client certificate, select theUseClient Certificate check box and configure theCertificate
File Path field and Certificate Password fields.

10.Configure a CIDR range for your scanner, configure the CIDR range parameters and click Add.
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NOTE: The QualysGuard Host Detection List API accepts only CIDR ranges to a maximum of
a single class A or /8 and must not encompass the local host IP address (127.0.0.1) or 0.0.0.0.

11.Click Save.

12.On the Admin tab, click Deploy Changes. Changes to the proxy configuration require a Deploy Full
Configuration.
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Adding a Qualys Scheduled Live Scan

Add a scheduled live scan to start preconfigured scans on theQualys Scanner and then collect the completed
scan results.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify your Qualys scanner.

5. From theManaged Host list, select the managed host that manages the scanner import.

6. From the Type list, select Qualys Scanner.
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7. Configure the following parameters:

DescriptionParameter

The Fully Qualified Domain Name (FQDN) or IP address
of the QualysGuard management console. If you type the
FQDN, the host name and not the URL, for example, type
qualysapi.qualys.com or qualysapi.qualys.eu.

Qualys Server Host Name

The user name that you specify must have access to
download the Qualys KnowledgeBase. For more
information about how to updateQualys subscription, see
your Qualys documentation.

Qualys Username

The password for your Qualys login.Qualys Password

8. Optional: To configure a proxy, select the Use Proxy check box and configure the credentials for the
proxy server.

9. Optional: To configure a client certificate, select the Use Client Certificate check box and configure
the Certificate File Path field and Certificate Password fields.

10. From the Collection Type list, select Scheduled Live - Scan Report.

11.Configure the following parameters:

DescriptionParameter

To obtain the scanner name, contact your network
administrator. Public scanning appliance must clear the
name from this field.

Scanner Name

The name of the option profile that determines which live
scan is started. Live scans support only one option profile
name for each scanner configuration.

Option Profiles

12.Optional: To configure a CIDR range for your scanner, configure the CIDR range parameters and click
Add.

13.Optional: To enable JSA to create custom vulnerabilities from the live scan data, select the Enable
Custom Vulnerability Creation check box and select options that you want to include.
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14.Click Save.

15.On the Admin tab, click Deploy Changes. Changes to the proxy configuration require a Deploy Full
Configuration.
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Adding a Qualys Scheduled Import Asset Report

Add an asset report data import to schedule JSA to retrieve a single asset report from your Qualys scanner.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify your Qualys scanner.

5. From theManaged Host list, select the managed host that manages the scanner import.

6. From the Type list, select Qualys Scanner.

7. Configure the following parameters:

DescriptionParameter

The Fully Qualified Domain Name (FQDN) or IP address
of the QualysGuard management console. If you type the
FQDN, the host name and not the URL, for example, type
qualysapi.qualys.com or qualysapi.qualys.eu.

Qualys Server Host Name
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DescriptionParameter

The user name that you specify must have access to
download the Qualys KnowledgeBase. For more
information about how to updateQualys subscription, see
your Qualys documentation.

Qualys Username

The password for your Qualys login.Qualys Password

8. Optional: To configure a proxy, select the Use Proxy check box and configure the credentials for the
proxy server.

9. Optional: To configure a client certificate, select the Use Client Certificate check box and configure
the Certificate File Path field and Certificate Password fields.

10. From the Collection Type list, select Scheduled Import - Asset Data Report.

11.Configure the following parameters:

DescriptionParameter

The report template title to replace the default asset data
report title.

Report Template Title

Files that are older than the specified days and time stamp
on the report file are excluded when the schedule scan
starts.

Max Reports Age (Days)

The directory path to download and import a single asset
report from Qualys. If you specify an import file location,
JSA downloads the contents of the asset report from
Qualys to a local directory and imports the file. If you leave
this field blank or if the file or directory cannot be found,
the Qualys scanner uses the API to retrieve the asset
report by using the value in the Report Template Title
field.

Import File

12.Optional: To configure a CIDR range for your scanner, configure the CIDR range parameters and click
Add.

13.Optional: To enable JSA to create custom vulnerabilities from the live scan data, select the Enable
Custom Vulnerability Creation check box and select options that you want to include.
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14.Click Save.

15.On the Admin tab, click Deploy Changes. Changes to the proxy configuration require a Deploy Full
Configuration.
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Adding a Qualys Scheduled Import Scan Report

Add a scan report data import to schedule JSA to retrieve scan reports from your Qualys scanner.

1. On the Admin tab, click the VA Scanners icon, and then click Add.

2. In the Scanner Name field, type a name to identify your Qualys scanner.

3. Give your Qualys scanner a name and description.

4. From the Type list, select Qualys Scanner.

5. Configure the following parameters:

DescriptionParameter

The fully qualified domain name (FQDN) or IP address of
the QualysGuard management console. If you type the
FQDN, the host name and not the URL, use the following
syntax qualysapi.qualys.com or qualysapi.qualys.eu.

Qualys server host name

The user name that you specify must have access to
download the Qualys KnowledgeBase. For more
information about how to updateQualys subscription, see
your Qualys documentation.

Qualys username

The password for your Qualys login.Qualys password
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6. If you use a proxy server, select the Use Proxy check box and configure the credentials for the proxy
server.

7. If a client certificate is required for your Qualys account, select the Use Client Certificate check box
and configure the Certificate File Path field and Certificate Password fields.

8. From the Collection Type list, select Scheduled Import - Scan Report. This option pulls in the scan
results from the Scans tab of the Qualys Enterprise console.

9. Configure the following parameters:

DescriptionParameter

The name of the option profile to determine which scan
to start. JSA retrieves the completed live scan data after
the live scan completes. Live scans support only one option
profile name per scanner configuration.

Option Profiles

The regular expression (regex) to filter the list of scan
reports.

Scan Report Name Pattern

Files that are older than the specified days and time stamp
on the report file are excluded when the schedule scan
starts.

Max Reports Age (Days)

The directory path to download and import a single scan
report from Qualys, for example,
/qualys_logs/test_report.xml. If you specify an import file
location, JSA downloads the contents of the asset report
from Qualys to a local directory and imports the file. If
you leave this field blank or if the file or directory cannot
be found, the Qualys scanner uses the API to retrieve the
asset report by using the value in theOptions Profile field.

Import File

10.To create custom vulnerabilities from the live scan data, select the Enable CustomVulnerability Creation
check box, and then select options that you want to include.

11. To configure a CIDR range for your scanner, configure the CIDR range parameters and click Add.

12.Click Save.

You are now ready to create a scan schedule. See “Scheduling a Vulnerability Scan” on page 195.
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Rapid7 NeXpose Scanners Overview

Rapid7 NeXpose scanners can provide site data reports to JSA to import vulnerabilities known about your
network.

The following options are available to collect vulnerability information from Rapid7 NeXpose scanners:

• Site import of an adhoc reports through the Rapid7 API. See “Adding a Rapid7 NeXpose Scanner API
Site Import” on page 161.

• Site import of a local file. See “Adding a Rapid7 NeXpose Scanner Local File Import” on page 159

• Site import of a remote file. See “Adding a Rapid7 Nexpose Scanner Remote File Import” on page 163

Adding a Rapid7 NeXpose Scanner Local File Import

JSA uses local files to import site vulnerability data from your Rapid7 Nexpose scanner.

Before you add this scanner, a server certificate is required to support HTTPS connections. JSA supports
certificates with the following file extensions: .crt, .cert, or .der. To copy a certificate to the
/opt/qradar/conf/trusted_certificates directory, choose one of the following options:

• Manually copy the certificate to the /opt/qradar/conf/trusted_certificates directory by using SCP or
SFTP.

• SSH into the Console or managed host and retrieve the certificate by using the following command:
/opt/qradar/bin/getcert.sh <IP or Hostname> <optional port - 443 default>. A certificate is then
downloaded from the specified host name or IP and placed into /opt/qradar/conf/trusted_certificates
directory in the appropriate format.

Local file imports collect vulnerabilities for a site from a local file that is downloaded. The Rapid7 NeXpose
XML file that contains the site and vulnerability information must be copied from your Rapid7 NeXpose
appliance to the Console or managed host you specify when the scanner is added to JSA. The destination
directory on the managed host must exist before the Rapid7 NeXpose appliance can copy site reports to
the managed host. The site files can be copied to the managed host using Secure Copy (SCP) or Secure
File Transfer Protocol (SFTP).

The import directory created on the managed host or JSA console must have the appropriate owner and
permission set on it for the vis user within JSA. For example, chown -R vis:qradar <import_directory_path>
and chmod 755 <import_directory_path> set the owner of the import directory path to vis user with
adequate read-write-execute permissions.
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NOTE: Site files that are imported are not deleted from the import folder, but renamed to
.processed0. Administrators can create a cron job to delete previously processed site files.

You must use the XML Export or XML Export 2.0 report format for the XML export to JSA.

XML Export is also known as raw XML. The XML export contains an extensive set of scan data with the
smallest amount of structure. The XML export scan data must be parsed so that other systems can use
the information.

XML Export 2.0 is similar to XML Export, but has more attributes:

• Asset Risk

• Exploit Title

• Site Name

• Exploit IDs

• Malware Kit Name(s)

• Site Importance

• Exploit Skill Needed

• PCI Compliance Status

• Vulnerability Risk

• Exploit Source Link

• Scan ID

• Vulnerability Since

• Exploit Type

• Scan Template.

1. Click Admin > System Configuration.

2. Click the VA Scanners icon, and then click Add.

3. Type a Scanner Name to identify your Rapid7 NeXpose scanner.

4. Select theManaged Host from your JSA deployment that manages the scanner import.

5. Select Rapid7 Nexpose Scanner from the Type list.
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6. From the Import Type list, select Import Site Data - Local File.

7. Type the directory path to the XML vulnerability data in the Import Folder field. If you specify an import
folder, you must move the vulnerability data from your Rapid7 Nexpose scanner to JSA.

8. In the Import Name Pattern field, type a regular expression (regex) pattern to determine which Rapid7
Nexpose XML files to include in the scan report. All file names that match the regex pattern are included
when the vulnerability scan report is imported. You must use a valid regex pattern in this field. The
default value ..*\.xml imports all files from the import folder.

9. Enter the CIDR range that you want this scanner to consider or click Browse to select a CIDR range
from the network list.

10.Click Save.

11.On the Admin tab, click Deploy Changes.

You are now ready to create a scan schedule. See “Scheduling a Vulnerability Scan” on page 195.
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Adding a Rapid7 NeXpose Scanner API Site Import

API imports enable JSA to import ad hoc report data for vulnerabilities on your sites from Rapid7 NeXpose
scanners. The site data the scan schedule imports depends on the site name.

Before you add this scanner, a server certificate is required to support HTTPS connections. JSA supports
certificates with the following file extensions: .crt, .cert, or .der. To copy a certificate to the
/opt/qradar/conf/trusted_certificates directory, choose one of the following options:

• Manually copy the certificate to the /opt/qradar/conf/trusted_certificates directory by using SCP or
SFTP.

• SSH into the Console or managed host and retrieve the certificate by using the following command:
/opt/qradar/bin/getcert.sh <IP or Hostname> <optional port - 443 default>. A certificate is then
downloaded from the specified host name or IP and placed into /opt/qradar/conf/trusted_certificates
directory in the appropriate format.
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1. Click Admin > System Configuration.

2. Click the VA Scanners icon, and then click Add.

3. Type a Scanner Name to identify your Rapid7 NeXpose scanner.

4. Select theManaged Host from your JSA deployment that manages the scanner import.

5. Select Rapid7 Nexpose Scanner from the Type list.

6. From the Import Type list, select Import Site Data - Local File.

• Import Site Data - Asset and Vulnerability data via SQL API - Default and suggested option for
importing results.

• Import Site Data - Adhoc Report via API

7. In the Remote Hostname field, type the IP address or host name of the Rapid7 NeXpose scanner.

8. In the Login Username field, type the user name that is used to access the Rapid7 NeXpose scanner.
The login must be a valid user. The user name can be obtained from the Rapid7 NeXpose user interface
or from the Rapid7 NeXpose administrator.

9. In the Login Password field, type the password to access the Rapid7 NeXpose scanner.

10. In the Port field, type the port that is used to connect to the Rapid7 NeXpose Security Console. The
port number is the same port to connect to the Rapid7 NeXpose user interface.

11. In the SiteNamePattern field, type the regular expression (regex) to determinewhich Rapid7NeXpose
sites to include in the scan. All sites that match the pattern are included when the scan schedule starts.
The default value regular expression is .* to import all site names.

12. In the Cache Timout (Minutes) field, type the length of time the data from the last generated scan
report is stored in the cache.

If the cache timeout limit expires, new vulnerability data is requested from the API when the scheduled
scan starts.

13. Enter the path to the local directory to store downloaded XML reports.

14. To configure a CIDR range for the scanner complete the following steps:

a. In the text field, type the CIDR range for the scan or click Browse to select a CIDR range from the
network list.

162



b. Click Add.

15.Click Save.

16.On the Admin tab, click Deploy Changes.

You are now ready to create a scan schedule. See “Scheduling a Vulnerability Scan” on page 195.
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Adding aRapid7Nexpose Scanner Remote File Import

JSA uses remote files to import site vulnerability data from your Rapid7 Nexpose scanner.

Before you add this scanner, make sure that you have a server certificate that supports HTTPS connections.
JSA supports certificates with the following file extensions: .crt, .cert, or .der. To copy a certificate to the
/opt/qradar/conf/trusted_certificates directory, choose one of the following options:

• Manually copy the certificate to the /opt/qradar/conf/trusted_certificates directory by using SCP or
SFTP.

• Use SSH to log in to the Console or managed host and retrieve the certificate by using the following
command: /opt/qradar/bin/getcert.sh <IP or Hostname> <optional port - 443 default>. A certificate is
then downloaded from the specified host name or IP and placed into /opt/qradar/conf/
trusted_certificates directory in the appropriate format.

Remote file imports collect vulnerabilities for a site from a remote file that is downloaded. The Rapid7
Nexpose XML file that contains the site and vulnerability information must be copied from your Rapid7
Nexpose appliance to the Console or managed host you specify when the scanner is added to JSA. The
destination directory on the managed host or Console must exist before the Rapid7 Nexpose appliance
can copy site reports. The site files can be copied to the managed host or Console by using Secure Copy
(SCP) or Secure File Transfer Protocol (SFTP).

The import directory that is created on themanaged host or JSAConsolemust have the appropriate owner
and permission set on it for the VIS user within JSA. For example, chown -R vis:qradar
<import_directory_path> and chmod 755 <import_directory_path> set the owner of the import directory
path to VIS user with adequate read-write-execute permissions.
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NOTE: Site files that are imported are not deleted from the import folder, but renamed to
.processed0. Administrators can create a cron job to delete previously processed site files.

1. Click Admin > System Configuration.

2. Click the VA Scanners icon, and then click Add.

3. Type a Scanner Name to identify your Rapid7 NeXpose scanner.

4. Select theManaged Host from your JSA deployment that manages the scanner import.

5. Select Rapid7 Nexpose Scanner from the Type list.

6. From the Import Type list, select Import Site Data - Remote File.

7. Enter the Remote Hostname of the server that has the scan result files and the Remote Port of the
remote SSH server.

8. Enter the user name and password for the remote SSH server.

9. Optional: Enable key authentication, and then enter the full local path to the SSH private key file.

10. Indicate the location of the remote directory that contains the scan results on the remote SSH server.

11. In the File Name Pattern field, type a regular expression (regex) pattern to determine which Rapid7
Nexpose XML files to include in the scan report. All file names that match the regex pattern are included
when the vulnerability scan report is imported. You must use a valid regex pattern in this field. The
default value .*\.xml imports all files from the import folder.

12. Enter the maximum number of days to use the report file. Files older than this number of days aren't
processed. Set the number to 0 if you want to disable report age checking.

13.Configure a CIDR range for your scanner:

a. In the field, type the CIDR range that you want this scanner to consider or click Browse to select a
CIDR range from the network list.

b. Click Add.

164



14.Click Save.

15.On the Admin tab, click Deploy Changes.

You are now ready to create a scan schedule. See “Scheduling a Vulnerability Scan” on page 195.
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SAINT Security Suite Scanner

JSA collects and imports scan reports from Security Administrator's Integrated Network Tool (SAINT)
Security Suite vulnerability appliances by JSA using the SAINT API. SAINT Security Suite scan reports
include vulnerability data, MAC addresses, port information, and service information.

To integrate SAINT Security Suite with JSA, complete the following steps:

1. From your SAINT Security Suite appliance, obtain and record the SAINT API port number. You need
this informationwhen you add a scanner in JSA. See“Obtaining the SAINTAPI PortNumber” on page 170.

2. From your SAINT Security Suite appliance, obtain and record the SAINT API token. You need this
information when you add a scanner in JSA. See “Obtaining the SAINT API Token” on page 171.

3. From your SAINT Security Suite appliance, configure the SAINT API to send scan reports to JSA. See
“Adding a JSA Host to the Allowed API Clients List” on page 171.

4. Copy the server certificate to supportHTTPS connections. See “Copy the Server Certificate” on page 172.

5. From your JSA Console, add a SAINT Security Suite vulnerability scanner. See “Adding a SAINT Security
Suite Vulnerability Scanner in JSA” on page 173.

The SAINT Security Suite vulnerability scanner supports the Live Scan and Report Only scan options
in JSA.

• Live scan - If you select this option when you add a SAINT Security Suite scanner in JSA, JSA starts
a live remote vulnerability scan on the SAINT Scanner. When the scan is complete, JSA collects and
imports the vulnerability scan report. You might want to select this option if you don't have any
existing scans on the SAINT Security Suite appliance.

• Report only - If you select this option when you add a SAINT Security Suite scanner in JSA, JSA
imports only scan reports for scans that exist on the SAINT Security Suite appliance. You might want
to select this option if the SAINT Security Suite appliance has scans that are scheduled to run regularly.

6. From your JSA Console, create a scan schedule for the scanner that you added. See “Scheduling a
Vulnerability Scan” on page 195.

RELATED DOCUMENTATION

Copy the Server Certificate | 172

Obtaining the SAINT API Port Number | 170

Obtaining the SAINT API Token | 171

Adding a JSA Host to the Allowed API Clients List | 171

169



Scheduling a Vulnerability Scan | 195

Obtaining the SAINT API Port Number

Before you can add a SAINT Security Suite scanner in JSA, you must obtain and record the SAINT API
port number from the SAINT web console.

The SAINTAPI port is the port on the SAINT Security Suite appliance that the SAINT API uses for listening.
JSA uses the SAINT API port to send API requests to the SAINT Security Suite scanner.

You must be a SAINT user with the necessary permissions and have the web address for the SAINT web
console. These items are supplied by your scanner administrator.

1. Log in to the SAINT web console by using the web address that you use to access the SAINT Security
Suite appliance. The web address is provided by your SAINT Security Suite scanner administrator.

2. Click Configuration > System Options.

3. Click the API tab, and then record the SAINT API port number that is displayed in the API Port field.

Use the SAINT API port number when you add the SAINT Security Suite scanner in JSA.
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Obtaining the SAINT API Token

Before you can add a SAINT Security Suite scanner in JSA, you must obtain the SAINT API token from the
SAINT web console. The SAINT API token is a unique identifier that is used by JSA to authenticate API
requests to the SAINT Security Suite scanner.

You must be a SAINT user with the necessary permissions and have the web address for the SAINT web
console. These items are supplied by your scanner administrator.

1. Log in to the SAINTweb console by using the web address that you use to access the SAINT appliance.
The web address is provided by your SAINT Security Suite scanner administrator.

2. From the menu bar, select Profile.

3. In the User Profile window, record the value in the API Token field.

Use the API token that you recorded when you add the SAINT Security Suite scanner in JSA.
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Adding a JSA Host to the Allowed API Clients List

Before you can add a SAINT Security Suite scanner in JSA, you must add the IP address for your JSA
Console to the list of allowed API clients on the SAINT web console.

You must be a SAINT user with the necessary permissions and have the web address for the SAINT web
console. These items are supplied by your scanner administrator.
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1. Log in to the SAINT web console by using the web address that you use to access the SAINT Security
Suite appliance.

2. Click Configuration > System Options.

3. Click the API tab.

4. In the Allowed API Clients field, type the IP address of your JSA host. If you want to specify more than
one JSA host, you can type multiple IP addresses in a comma-separated list.

5. Click Save.
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Copy the Server Certificate

You need a server certificate to support HTTPS connections. JSA supports certificates with the .crt, .cert,
or .der file extensions.

To copy a certificate to the /opt/qradar/conf/trusted_certificates directory, choose one of the following
options:

1. Manually copy the certificate to the /opt/qradar/conf/trusted_certificates directory by using SCP or
SFTP.

2. Use SSH to log in to the JSAConsole ormanaged host and retrieve the certificate by typing the following
command:

/opt/qradar/bin/getcert.sh <IP or Hostname of the SAINT API><Port of the SAINT API>
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A certificate is downloaded from the specified host name or IP address and placed into the
/opt/qradar/conf/trusted_certificates directory in the appropriate format.
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Adding a SAINT Security Suite Vulnerability Scanner
in JSA

JSA uses the SAINT API to collect and import scan reports from your SAINT Security Suite appliance.

Before you can add the SAINT Security Suite vulnerability scanner in JSA, you need to complete the
following steps:

1. “Obtaining the SAINT API Port Number” on page 170.

2. “Adding a JSA Host to the Allowed API Clients List” on page 171.

3. “Obtaining the SAINT API Token” on page 171.

4. “Copy the Server Certificate” on page 172.

1. Log in to the JSA Console.

2. Click the Admin tab.

3. Click the VA Scanners icon, and then click Add.

4. In the Scanner Name field, type a name to identify your SAINT Security Suite scanner.
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5. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.

6. From the Type list, select SAINT Security Suite Scanner.

7. In the Remote API Hostname field, type the IP address or the host name for the SAINT API.

8. In the API Port field, type the SAINT API port number. For more information about the API port, go to
“Obtaining the SAINT API Port Number” on page 170.

9. In the API Token field, type the SAINT API token. For more information about the SAINT API token,
go to “Obtaining the SAINT API Token” on page 171.

10. From the Scan Type list, select one of the following scan type options:

DescriptionOption

JSA creates and runs a new scan on the SAINT Security
Suite appliance. After the scan completes, JSA collects
and imports a scan report from the SAINT Security Suite
appliance.

Live Scan

JSA collects and imports scan reports for all scans that are
already on the SAINT Security Suite appliance that match
the following requirements.

• The scan is not older than the age specified in theMax
Report Age field.

• The scan level of the scan matches the specified Scan
Level.

• The target map of the scan has at least one IP address
in common with the CIDR range.

This option does not start new scans on the SAINT
Security Suite appliance. To collect accurate results, ensure
that relevant, regularly run scans are scheduled on the
SAINT Security Suite appliance.

Report Only

11. From the Scan Level list, select a scan level that you want to use from the following options.
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NOTE: On the SAINT Security Suite appliance and in SAINT Security Suite documentation, scan
levels are referred to as scan policies. Formore informationOVAL/SCAP scans, go to the SAINT
Security Suite documentation website . From the navigation pane, click User Guide > SCAP.

DescriptionScan level

SAINT collects information to get the general character of
a host and establishes the operating system type and, if
possible, the software release version.

Normal

The Heavy/Vulnerability Scan level is also known as the
heavy policy. SAINT looks for services that are listening
on TCP or UDP ports. Any services that are detected are
scanned for any known vulnerabilities. This scan includes
SAINT's entire set of vulnerability checks, and is the scan
policy that SAINT suggests you use in most situations.

Heavy/Vulnerability Scan

SAINT scans the targets and determines which targets
have live hosts. This scan level only completes theminimum
scanning that is required to identify live hosts. Therefore,
the Discovery scan is not very intrusive.

Discovery

SAINT identifies services that are listening on TCP or UDP
ports.

Port Scan

SAINT detects web directories on the targets by scanning
ports for web services, and then finds directories by
following HTML links, starting from the home page.

Web Crawl

SAINT looks for SQL injection and cross-site scripting
vulnerabilities on web servers. Both generic tests are
included. SAINT findsHTML forms and tests all parameters
for SQL injection and cross-site scripting, and then checks
for known SQL injection and cross-site scripting
vulnerabilities.

SQL/XSS

SAINT looks for missing Windows patches. Most of the
checks for Windows patches require Windows domain
authentication.

Windows Patch
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DescriptionScan level

SAINT searches files on Windows and Linux/Mac targets
for credit card numbers, social security numbers, or any
other patterns that are specified. Authentication is needed.
If you are scanning a Linux/Mac target, SSH must be
enabled.

Content Search

SAINT scans the targets by using all vulnerability checks
that are relevant for Payment Card Industry and Data
Security Standard (PCI DSS) compliance.

PCI

Information is collected about installed AV software, such
as last scan date, enabled, definition file dates, and other
information that is useful for auditing requirement 5 of the
PCI DSS. Information is also collected for Windows
versions for many of the AV software products, such as
McAfee, Symantec, AVG, F-Secure, MS Forefront, and
Trend Micro. Authentication is needed. Facts that contain
the string '(Master)' indicate that an anti-virus server,
manager, or admin is installed on the target.

Anti-virus Information

SAINT scans the targets by using all vulnerability checks
that are relevant for Federal Information Security
Management Act (FISMA) compliance.

FISMA

SAINT authenticates against the targets by using the
credentials that are specified when adding a vulnerability
scanner.

Authentication Test

Completes password guess checks againstWindows targets
by using the password guess and password dictionary
configuration options. Authentication is suggested for
SAINT to enumerate accounts.

Win Password Guess

Checks for the last published Microsoft patch Tuesday
vulnerabilities on the second Tuesday of each month. This
scan level and associated content are usually updated by
SAINTexpress by noon on Wednesday.

Microsoft Patch Tuesday
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DescriptionScan level

Checks for vulnerabilities in web servers and web
applications, such as SQL injection, cross-site scripting,
unpatched web server software, weak SSL ciphers, and
other OWASP Top 10 vulnerabilities. It also enables file
content checks. Authentication might be necessary for
some of the checks that are included.

Web Scan (OWASP Top 10)

SAINT scans the targets by using all vulnerability checks
that are relevant for Information Assurance Vulnerability
Alert (IAVA) compliance.

IAVA (Maps CVEs to IAVA codes)

Includes all SAINT password guess features that are
designed to guess the operating system password. This
policy includes checks for default FTP passwords, and
dictionary-based password guesses through Telnet, SSH,
and FTP. Authentication is suggested to ensure user
account enumeration.

OS Password Guess

SAINT scans the targets by using all vulnerability checks
that are relevant for North American Electric Reliability
Corporation and Critical Infrastructure Protection (NERC
CIP) compliance.

NERC CIP

Generates a list of software that is installed on Windows
targets. Authentication is needed. The software list is
generated by enumerating the uninstall key in theWindows
registry. Only software that was registered with the
operating system during installation is included. Software
that was placed on the systemwithout running an installer
program is usually omitted. Registered software that was
incorrectly removed from the systemmight be included in
the list after removal.

Software Inventory

SAINT scans the targets by using all vulnerability checks
that are relevant for Health Insurance Portability and
Accountability Act (HIPAA) compliance.

HIPAA

SAINT scans the targets by using all vulnerability checks
that are relevant for Sarbanes-Oxley Act (SOX) compliance.

SOX
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DescriptionScan level

TheMobile Device scan level queries Active Directory
servers for information about mobile devices that use
Exchange ActiveSync, and then uses that information to
suggest vulnerabilities on those devices. The devices are
listed in the scan results as separate targets even though
those targets are not scanned.

For this scan level to succeed, OpenLDAPmust be installed
on the scanning host, and the scanmust runwithWindows
domain administrator credentials. For more information
about Authentication, go to the SAINT Security Suite
documentation website - Step 4 – Authentication.

The target list must include at least one Active Directory
server, and the SSL certificate for that Active Directory
server is installed and configured on the scanning host. For
more information aboutWindows Targets, go to the SAINT
Security Suite documentatin website - Authenticating to
Windows Targets.

Mobile Device

Checks for vulnerabilities in routers, switches, and other
networking devices.

Network Device

Runs an OVAL/SCAP scan.

For more information about OVAL/SCAP scans, go to the
SAINT Security Suite documentation website. From the
navigation pane, click User Guide > Using SAINT > SCAP.

OVAL Scan

For more information about SAINT scan parameters, go to the SAINT Security Suite documentation
website and complete the following steps. From the navigation pane, click User Guide > Using SAINT
> Jobs Tab.

12. If you selectedOVAL Scan from the Scan Level list, type the name of the scan policy that you want to
use in the OVAL Scan Policy Name field. OVAL/SCAP scans are types of scans that are based on
benchmarks that are collected from authoritative sources.

13. If you selected Live Scan for the scan type, provide the scan target credentials that are used to
authenticate targets during scans. From the Scan Target Credentials Type list, select one of the following
options for the credentials that you want to use:
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NOTE: Scan Target credentials are ignored when Report Only is selected for the scan type.

DescriptionOption

Do not use any credentials.None

Use credentials for basic HTTP credentials.HTTP Basic

Use credentials for connecting to a Linux, UNIX, or Mac
server through SSH.

Linux/Unix/Mac (SSH)

Use credentials for connecting to a Microsoft SQL Server
database.

Microsoft SQL Server

Uses credentials for connecting to an Oracle database.Oracle

Use credentials of an administrator account on aWindows
server.

Windows Admin

Use credentials of a non-administrator account on a
Windows server.

Windows non-Admin

Use credentials for connecting to a MySQL database.MySQL

Use SNMPv3 credentials.SNMPv3

14. If you selected any of the options, except for the None option from the Scan Target Credentials Type
list, configure the following parameters for the Scan Target Credentials that you selected:

ValueParameter

The user name for the scan target credential that you
selected.

Scan Target Credentials Username

The password for the scan target credential that you
selected.

Scan Target Credentials Password

15.Optional: If you selected Linux/Unix/Mac (SSH) from the Scan Target Credentials Type list, specify
the SSH Private Key.
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16.Optional: If you selectedOracle from the Scan Target Credentials Type list, you can specify an Oracle
Service ID (SID) of an Oracle database instance by typing it in the Oracle SID field.

17.Optional: If you selected SNMPv3 from the Scan Target Credentials Type list, complete the following
steps:

a. Select one of the following checksum algorithm options from the SNMP Password Protocol list:

DescriptionOption

Select this option for the password that you typed in the
Scan Target Credentials Password field to use the SHA
protocol.

SHA

Select this option for the password that you typed in the
Scan Target Credentials Password field to use the MD5
protocol

MD5

b. Optional: You can specify an SNMP passphrase by typing it in the SNMP Passphrase field. If you
specified an SNMP Passphrase, select one of the following options from the SNMP Passphrase
Protocol list:

DescriptionOption

Select this option for the passphrase that you typed in the
SNMP passphrase field to use the DES protocol.

DES

Select this option for the password that you typed in the
SNMP passphrase field to use the AES protocol.

AES

18. If you selected Report Only from the Scan Type list, type the maximum age of scan reports that you
want to import in theMax Report Age field.

19.Configure CIDR ranges for the scanner:

a. In the CIDR Ranges field, type the CIDR range for the scan or click Browse to select a CIDR range
from the network list.

b. Click Add.

20.Click Save.
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Tenable.io Scanner Overview

JSA collects and imports scan reports from Tenable.io by using the Tenable.io API. Tenable.io scan reports
include vulnerability data, MAC addresses, port information, and service information.

To integrate Tenable.io with JSA, complete these steps:

• Obtain and record the Tenable.io API Access key and Secret key from Tenable.io. You need this
information when you add a scanner in JSA.

• From your JSA Console, add a Tenable.io scanner.

• From your JSA Console, schedule a vulnerability scan.
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Obtaining the Tenable.io API Access key and Secret
key

Youmust obtain the Tenable.io API Access and Secret keys fromTenable.io before you can add a Tenable.io
scanner in JSA. JSA collects vulnerability information by using the Tenable.io API.

1. Log in to Tenable.io as Administrator.

2. Click the API Keys tab.

3. Click Generate, and then record the Access key and Secret key values. These keys are used to
authenticate with the Tenable.io REST API. You will need these values when you add a Tenable.io
scanner in JSA.
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NOTE: Existing API keys are replaced. You must update the applications where previous API
keys were used.

You are now ready to add a scanner in JSA. See “Adding a Tenable.io Scanner to JSA” on page 186.
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Adding a Tenable.io Scanner to JSA

You can add a Tenable.io scanner to enable JSA to collect host and vulnerability information through the
Tenable.io API.

You must be a Tenable.io user, and you must have the Tenable.io API Public key and Secret key. For more
information, see “Obtaining the Tenable.io API Access key and Secret key” on page 185.

1. Click the Admin tab, click the VA Scanners icon in the Data Sources section, and then click Add.

2. In the Scanner Name field, type a name to identify your Tenable.io scanner.

3. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.

4. From the Type list, select Tenable.io.

5. In the API End point field, type cloud.tenable.com.

6. In the Access Key field, type the Tenable.io Access key value that you recorded when you completed
the “Obtaining the Tenable.io API Access key and Secret key” on page 185.

7. In the Secret Key field, type the Tenable.io Secret key value that you recorded when you completed
the “Obtaining the Tenable.io API Access key and Secret key” on page 185.
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8. Select the Severity level(s) for which you want to filter the results.

9. Configure a CIDR range for the Tenable.io scanner. In the CIDR range field, type the CIDR range for
the scan, or click Browse to select a CIDR range from the network list.

10.Click Add, and then click Save.

11.On the Admin tab, click Deploy Changes.

You are now ready to create a scan schedule. See “Scheduling a Vulnerability Scan” on page 195.
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Tenable SecurityCenter Scanner Overview

A Tenable SecurityCenter scanner can be used to schedule and retrieve any open vulnerability scan report
records from Nessus vulnerability scanners on your network.

To configure a Tenable SecurityCenter scanner, see “Adding a Tenable SecurityCenter Scan” on page 191.

Adding a Tenable SecurityCenter Scan

You can add a Tenable SecurityCenter scanner to enable JSA to collect host and vulnerability information
through the Tenable API.

Verify the location of the API on your Tenable SecurityCenter.

A server certificate is required to support HTTPS connections. JSA supports certificates with the following
file extensions: .crt, .cert, or .der. To copy a certificate to the /opt/qradar/conf/trusted_certificates
directory, choose one of the following options:

• Manually copy the certificate to the /opt/qradar/conf/trusted_certificates directory by using SCP or
SFTP.

• SSH into the Console or managed host and retrieve the certificate by using the following command:
/opt/qradar/bin/getcert.sh <IP or Hostname> <optional port - 443 default>. A certificate is then
downloaded from the specified host name or IP and placed into /opt/qradar/conf/trusted_certificates
directory in the appropriate format.

1. Click the Admin tab.

2. Click the VA Scanners icon.

3. Click Add.

4. In the Scanner Name field, type a name to identify the scanner.

5. From theManaged Host list, select the managed host from your JSA deployment that manages the
scanner import.

6. From the Type list, select Tenable SecurityCenter.

7. In the Server Address field, type the IP address of the Tenable SecurityCenter.

191



8. In the API Location field, type the path to the API on the Tenable SecurityCenter.

The default path to the API file for SecurityCenter Version 4 is sc4/request.php.

The default path to the API file for SecurityCenter Version 5 is rest.

9. From theAPI Version list, select the version for your SecurityCenter. For example,Version 4 orVersion
5.

10. In the User Name field, type the user name to access the Tenable SecurityCenter API.

11. In the Password field, type the password to access the Tenable SecurityCenter API.

12.Configure a CIDR range for the scanner.

a. In the CIDR ranges field, type the CIDR range for the scan or click Browse to select a CIDR range
from the network list.

b. Click Add.

13.Click Save.

14.On the Admin tab, click Deploy Changes.

You are now ready to create a scan schedule. See “Scheduling a Vulnerability Scan” on page 195.
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Scheduling a Vulnerability Scan

Scan schedules are intervals assigned to scanners that determine when vulnerability assessment data is
imported from external scanning appliances in your network. Scan schedules can also define CIDR ranges
or subnets that are included in the data import when the vulnerability data import occurs.

Scan schedules are created for each scanner product in your network and are used to retrieve vulnerability
data. There is no limit to the number of scan schedules you can create. It is often helpful to create multiple
scans in your network for vulnerabilities in your network. Large vulnerability imports can take a long time
to complete and are often very system resource intensive. A scan cannot be scheduled until after the
scanner has been added.

1. Click the Admin tab.

2. Click the Schedule VA Scanners icon.

3. Click Add.

4. From the VA Scanners list, select the scanner that requires a scan schedule.

5. Choose one of the following options:

DescriptionOption

Select this option to define a CIDR range for the data
import.

If a scanner includes multiple CIDR configurations, then
the CIDR range can be selected from the list.

Network CIDR

Select this option to define a subnet or CIDR range for
the data import.

The subnet/CIDR value that is defined by the administrator
must be a Network CIDR that is available to the scanner.

Subnet/CIDR

6. From the Priority list, select the priority level to assign to the scan.

DescriptionOption

Indicates the scan is of normal priority. Low priority is the
default scan value.

Low
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DescriptionOption

Indicates the scan is high priority.

High priority scans are always placed above low priority
scans in the scan queue.

High

7. In the Ports field, type the ports that are included in the scan schedule. Any ports that are not in the
schedule are not imported from the vulnerability data. Administrators can specify any port values from
1 - 65536. Individual port values can be included as comma-separate values, along with port ranges.
For example, 21,443, 445, 1024-2048.

8. Select the start time for the schedule.

9. In the Interval field, type a time interval to indicate how often you want this scan to repeat. Scans
schedules can contain intervals by the hour, day, week, or month.

10. Select Clean Vulnerability Ports to delete all vulnerabilities found on each asset, and replace with data
reported in the next scan run.

11.Click Save.
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Viewing the Status Of a Vulnerability Scan

The Scan Schedule window provides administrators a status view for when each scanner is scheduled to
collect vulnerability assessment data for asset in the network.

The name of each scan is displayed, along with the CIDR range, port or port range, priority, status, and
next run time.

Table 10: Scan Schedule Status

DescriptionColumn name

Displays the name of the schedule scan.VA Scanner

Displays the CIDR address ranges that are included in the vulnerability data import when the
scan schedule starts.

CIDR

Displays the port ranges that are included in the vulnerability data import when the scan
schedule starts.

Scan schedules are capable of starting a remote scan on a remote vulnerability appliance for
specific vendors. For example, NMap or Nessus, or Nessus Scan Results Importer, then the
ports listed in the Ports column are the ports contained in the scan.

For most scanners, the port range is not considered when requesting asset information from
a scanner.

For example, nCircle IP360 and Qualys scanners report vulnerabilities on all ports, but require
you to specify what port information to pull from the full report for display in the user interface.

Ports

Displays the priority of the scan.

Scans schedules with a high priority are queued above in priority and run before low priority
scans.

Priority

Displays the current status of the scan. Each status field contains unique information about
the scan status.

• New scans can be edited until the state changes.

• Pending scans must wait for another scan to complete.

• In progress scans provide a percentage complete with tooltip information about the data
import.

• Completed scans provide a summary of the vulnerabilities imported or any partial imports
of data that occurred.

• Failed scans provide an error message on why the vulnerabilities failed to import.

Status
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Table 10: Scan Schedule Status (continued)

DescriptionColumn name

Displays the last time the scan successfully imported vulnerability records for the schedule.Last Finish Time

Displays the next time the scan is scheduled to import vulnerability data. Scan schedules that
display Never in the user interface are one time scans.

Next Run Time

1. Click the Admin tab.

2. Click the Schedule VA Scanners icon.

3. Review the Status column to determine the status of your log sources.

The status column for each scanner provides a status message about each successful vulnerability
import or failure.
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Supported Vulnerability Scanners

Vulnerability data can be collected from several manufacturers and vendors of security products as shown
in Table 11 on page 203. If the scanner deployed in your network is not listed in this document, you can
contact your sales representative to review support for your appliance.

Table 11: Supported Vulnerability Scanners

Connection type
Configuration
nameSupported versionsScanner nameVendor

File import of vulnerability data
with SFTP

Beyond Security
AVDS Scanner

AVDS Management V12
(minor version 129) and
above

Automated
Vulnerability
Detection System
(AVDS)

Beyond
Security

HTTPSDigital Defense
Inc AVS

N/AAVSDigital
Defense
Inc

SNMP trap listenereEye REM
Scanner

REM V3.5.6eEye REMeEye
Digital
Security Database queries over JDBCRetina CS V3.0 to V4.0eEye Retina CS

File import of vulnerability data
with SFTP

Axis ScannerN/AAxisGeneric

IBM REST web service with HTTP
or HTTPS

IBMAppScan
Scanner

V8.6 to V9.0.3.10IBMAppScan
Enterprise

IBM

File import of vulnerability data
with SFTP

IBMGuardium
SCAP Scanner

v9.0 and aboveInfoSphereGuardiumIBM

SOAP-based API with HTTP or
HTTPS

IBM BigFix
Scanner

V8.2x to V9.5.2BigfixIBM

Database queries over JDBCIBMSiteProtector
Scanner

V2.9.xInfoSphereSite
Protector

IBM

Tivoli Endpoint
Manager

Nowknownas IBM
BigFix

IBM

203



Table 11: Supported Vulnerability Scanners (continued)

Connection type
Configuration
nameSupported versionsScanner nameVendor

Database queries over JDBCJuniper NSM
Profiler Scanner

2007.1r2NetScreen Security
Manager (NSM)
Profiler

Juniper
Networks

2007.2r2

2008.1r2

2009r1.1

2010.x

SOAP-based API with HTTPSMcAfee
Vulnerability
Manager

V6.8Vulnerability
Manager

McAfee

XML file importV7.0

V7.5

DCOM must be configured and
enabled

Microsoft SCCMMicrosoftWindowsMicrosoft System
Center
Configuration
Manager (SCCM)

Microsoft

File import of vulnerability data
with SFTP

nCircle ip360
Scanner

VnE Manager V6.5.2 to
V6.8.28

IP360nCircle or
Tripwire

Database queries over JDBCSecureScout
Scanner

V2.6SecureScoutnet
Vigilance

File import of vulnerability data
over SFTP with SSH command
execution

NMap ScannerV3.7 to V6.0NMapOpen
source

API over HTTPSOutpost24HIAB V4.1

OutScan V4.1

Outpost24Outpost24

204



Table 11: Supported Vulnerability Scanners (continued)

Connection type
Configuration
nameSupported versionsScanner nameVendor

SFTP or SMB SharePositive
Technologies
MaxPatrol

V8.24.4 and laterMaxPatrolPositive
Techn
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Table 11: Supported Vulnerability Scanners (continued)

Connection type
Configuration
nameSupported versionsScanner nameVendor

ologies

APIv2 over HTTPSQualys ScannerV4.7 to V8.1QualysGuardQualys

API Host Detection List over
HTTPS

Qualys
Detection
Scanner

V4.7 to V8.1QualysGuardQualys

Remote Procedure Call (RPC) over
HTTPS

Rapid7 NeXpose
Scanner

V4.x to V6.5NeXposeRapid7

Local file import of XML file over
SCP or SFTP to a local directory

File import of vulnerability data
over SFTP with SSH command
execution

Saint ScannerV7.4.xSecurity
Administrator's
IntegratedNetwork
Tool (SAINT)

Saint
Corporation

Tenable.ioTenable

JSON request over HTTPSTenable
SecurityCenter

V4 and V5Tenable
SecurityCenter

Tenable

File import over SFTP with SSH
command execution

Nessus ScannerLinux V4.0.2 to V4.4.x

MicrosoftWindows V4.2
to V4.4.x

NessusTenable

XML-RPC API over HTTPSLinux V4.2 to V5.x

MicrosoftWindows V4.2
to V5.x

JSON APILinux V6.x

Microsoft Windows V6
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